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Wirtskontrollierte Restriktion und Modifikation von

Bakterienviren

Arbeitsgruppe Reuter

Die Beobachtung, dass bestimmte Bakterienstamme die Vermehrung von Bakterienviren
(Bakteriophagen) stark einschranken, obwohl diese sich zuvor gut auf einem anderen
Stamm vermehrten, flihrte Anfang der flinfziger Jahre zur ersten Beschreibung des
Phanomens der wirtskontrollierten Restriktion von Bakteriophagen. Die Erklarung dieses
Phanomens gelang Werner Arber Anfang der 1960er Jahre: Verantwortlich flir die Hemmung
der Phagenvermehrung war die sequenzspezifische, endonukleolytische Spaltung der
viralen DNA durch Restriktionsendonukleasen. Einige der Phagen-Genome entgehen der
Restriktion und werden durch wirtseigene Methyltransferasen modifiziert, was sie zur
weiteren Vermehrung auf diesem Wirtsstamm beféahigt. Diese Modifikationen lassen sich
wegen ihrer Reversibilitdt nach Passage Uber einen anderen Wirtsstamm leicht von
Wirtsbereichsmutationen des Bakteriophagen unterscheiden. DNA-Restriktion und -
Modifikation sind die molekularen Prozesse, die das Phadnomen der wirtskontrollierten
Restriktion verursachen. Die Modifikation umfasst die Methylierung definierter Nukleotide
innerhalb der spezifischen von der Restriktionsendonuklease erkannten DNA-Sequenz.
DNA-Methyltransferase  und  Restriktionsendonuklease eines  Restriktions- und
Modifikationssystems erkennen dieselbe DNA-Sequenz. Die bakterieneigene DNA wird
nach der Replikation durch die DNA-Methyltransferase methyliert und dadurch vor der
Spaltung durch die korrespondierende Restriktionsendonuklease geschiitzt. Eindringende,
fremde DNA, z. B. virale DNA bei Infektion des Bakteriums durch Bakteriophagen, wird durch
die Restriktionsendonuklease gespalten, da sie nicht entsprechend methyliert ist. Die
Funktion der Restriktions-/Modifikationssysteme ist der Schutz der prokaryotischen Zelle vor

unkontrolliertem Eindringen fremder genetischer Elemente.

Entsprechend ihrer strukturellen und funktionellen Eigenschaften werden Restriktions-
/Modifikationsenzyme in vier verschiedene Klassen eingeteilt (vereinfacht in Tab. 1
dargestellt). Typ Il-Restriktions-Modifikationsenzyme sind am weitesten verbreitet und
strukturell einfach aufgebaut. Methyltransferase und Restriktionsendonuklease sind
unabhangige Enzyme. Typ-llI-Restriktionsendonukleasen schneiden die DNA spezifisch
meist innerhalb ihrer aus vier bis acht Basenpaaren bestehenden palindromischen
Erkennungssequenz. Die spezifische DNA-Erkennung und -Spaltung hat Typ |lI-

Restriktionsenzyme zu unentbehrlichen Hilfsmitteln in der Molekularbiologie werden lassen



(Restriktionskarten, Klonierungen, Moglichkeit der Veranderung von Genen). Gegenwartig
sind etwa 3800 Restriktionsenzyme mit etwa 300 verschiedenen DNA-Spezifitaten
identifiziert. Von 39 Restriktionsendonukleasen gibt es Informationen Uber deren

dreidimensionale Struktur.

Typ Strukturmerkmale Cofaktoren der DNA-Spaltung
Spaltung
I multifunktional; drei ver- | Mg**, ATP, AdoMet schneiden zufallig und
schiedene Untereinheiten, weit entfernt zwischen
drei strukturelle Gene zweien ihrer asymmetri-
schen Erkennungs-
sequenz
! einfach; separate Enzyme | Mg** schneiden innerhalb oder
fur Restriktion und Modifi- in der Nahe ihrer meist
kation, zwei strukturelle symmetrischen Erken-
Gene nungssequenz
1l multifunktional; zwei ver- Mg”, ATP schneiden in definiertem
schiedene Untereinheiten, Abstand zu ihrem asym-
zwei strukturelle Gene metrischen Erkennungsort
v Restriktionsendonuklease |Mg®*, GTP schneiden nur °C- oder
ohne dazugehorige DNA- *C-methylierte DNA-
Methyltransferase Erkennungsorte

Tabelle 1. Unterscheidungsmerkmale verschiedener Typen von Restriktions-
/Modifikationsenzymen (vereinfacht). Innerhalb der Typen | und Il existieren Unterfamilien
bzw. Untergruppen. EcoRIl zahlt zur Untergruppe IIE der Typ-ll-Enzyme.

Restriktions-/Modifikationssysteme konnen in den Bakterienzellen chromosomal, durch
Plasmide oder durch Phagen kodiert werden. Bei der Untersuchung von Escherichia coli
Isolaten auf Restriktion verschiedener Bakteriophagen wurde das EcoRII-System auf dem
Resistenzplasmid N3 selektiert. Die Gene fur die Restriktionsendonuklease und Methyl-
transferase sind kloniert, sowie deren Nukleotidsequenzen bestimmt. Sie werden von ver-
schiedenen Strangen in konvergenter Richtung transkribiert. Restriktionsendonuklease und
Methyltransferase erkennen die spezifische Sequenz 5'-{CCA/TGG. Der Pfeil symbolisiert
die Spaltposition, die Methylgruppe wird auf das zweite C Ubertragen (C5-Position) und
schitzt die genomische DNA vor Restriktion.

T3 ist ein virulenter Bakteriophage, dessen Genom ein lineares, doppelstrangiges DNA-
Molekil mit terminaler Redundanz ist. Es umfasst etwa 38.740 bp (mit 3 EcoRII-Erken-

nungsorten). Nach Adsorption an einen permissiven Wirtsstamm erfolgt die Injektion der



DNA, beginnend mit dem linken Ende des Genoms. Noch wahrend der Injektion setzt die
frGhe Transkription durch die wirtseigene RNA-Polymerase ein. Nachdem das Gen 1 trans-
kribiert ist, Ubernimmt die neusynthetisierte phageneigene RNA-Polymerase die weitere
Transkription. Notwendige Voraussetzung fur die Replikation der Phagen-DNA ist der nukle-
olytische Abbau der Wirts-DNA durch phagencodierte Nukleasen. Das erste vom linken
Ende des T3-Genoms codierte Protein ist ein S-Adenosylmethionin-hydrolysierendes Enzym
(SAMase), das den Methyldonor (S-Adenosylmethionin) zerstort und damit eine intrazellulare
Methylierung der Phagen-DNA verhindert. Das T3-Genom ist nachweislich véllig unmethy-
liert.

EcoRll ist eine Restriktionsendonuklease mit ungewohnlichen Anforderungen an ihr Sub-
strat. Zur Enzymaktivitdt braucht sie, im Gegensatz zu konventionellen Typ-II-
Restriktionsendonukleasen, die nur einen Erkennungsort fur die erfolgreiche DNA-Spaltung
bendtigen, die kooperative Wechselwirkung mit 2zwei Erkennungsorten. Einzelne
Erkennungsorte oder Erkennungsorte, die auf einem DNA-Molekil sehr weit voneinander
entfernt sind, werden nicht gespalten. Die Effizienz der funktionellen Kooperativitat verringert
sich mit zunehmendem Abstand zwischen den Erkennungsorten, wobei die maximal

tolerierte Distanz etwa bei 1 kb liegt.

Abbildung 1: Dreidimensionale Struktur eines EcoRIl-Monomers (Zhou et al., 2004).

Die EcoRIIl-Gesamtstruktur besteht aus 18 a-Helices und 13 B-Strangen und ist in zwei
Domanen geteilt, die durch eine flexible ,Gelenkstruktur® verbunden sind: eine N-terminale
Doméane (Aminosauren 1-172), die Linkerregion (Aminosauren 173-193) und eine C-termi-

nale Domane (Aminosduren 194-404) (Abb. 1). Die N-terminale Domane stellt eine



(zusatzliche) DNA-Bindungsdomane dar, hat aber keine katalytische Aktivitat. Die C-
terminale Doméane zeigt die typische Topologie einer Typll-Restriktionsendonuklease mit
einem zentralen flnfstrangigen [(-Faltblatt umgeben von a-Helices. Die DNA-
Bindungsdomanen beider EcoRIl-Monomere binden zunachst einen der beiden EcoRII-
Erkennungsorte in der DNA, den Aktivator oder allosterischen Effektor. Diese Bindung geht
mit Konformationsanderungen des Proteins einher und aktiviert die beiden Endonuklease-

Doméanen, den zweiten EcoRII-Erkennungsort (Substrat) zu binden und zu spalten.

Biochemische Analysen haben gezeigt, dass die isolierte C-terminale Domane (EcoRII-C)
mit einer etwa 100-fach hoheren Reaktionsgeschwindigkeit spaltet als der EcoRII-Wildtyp.
EcoRII-C enthadlt demnach alle essentiellen strukturellen und funktionellen Komponenten
einer Typll-Restriktionsendonuklease und kann jeden einzelnen Erkennungsort innerhalb
einer DNA spalten. Durch Strukturvergleiche der C-terminalen EcoRIl Endonuklease-
Domane mit den sehr ahnlich aufgebauten Restriktionsendonukleasen NgoMIV und Cfr10l,
konnte das aktive Zentrum von EcoRIl vorhergesagt werden. In dieses aktive Zentrum wurde
eine DNA mit einem EcoRII-Erkennungsort modelliert und festgestellt, dass der Zugang zum
aktiven Zentrum partiell von der N-terminalen Domane blockiert wird. Das aktive Zentrum

von EcoRll ist also fir die Substrat-DNA a priori nicht zuganglich.

Die EcoRII-Kristallstruktur und insbesondere die Beobachtung, dass die EcoRII-Restriktions-
endonuklease durch die Entfernung der N-terminalen Proteindomane aktiviert wird, sugge-
riert, dass EcoRII durch einen Autoinhibitionsmechanismus reguliert wird: die N-terminale
Doméne (inhibitorische Domane) blockiert die funktionelle endonukleolytische Doméane. In
Abwesenheit von DNA liegt die Restriktionsendonuklease EcoRIl als inaktives Dimer vor. In
diesem inaktiven Zustand sind nur die N-terminalen Domanen (Effektor-Domanen) fir DNA
zuganglich, wahrend das aktive Zentrum im C-terminalen Teil von EcoRIl durch die N-
Termini rdumlich blockiert wird. In Anwesenheit von DNA bindet das erste DNA-Molekl
zunachst an die Effektor-Domanen und fuhrt zu Konformationsanderungen, die dann die
Bindung eines zweiten DNA-Molekiils an die C-terminalen Domanen ermdglichen. Dieser
Mechanismus der strengen Kontrolle der Aktivitat war bisher nur fir Transkriptionsfaktoren
und eukaryotische Signaltransduktionsproteine beschrieben und ist das erste Beispiel, dass
Restriktionsendonukleasen Uber diesen Mechanismus reguliert werden konnen.
Mutationsanalysen haben gezeigt, dass die Kontrolle der enzymatischen Aktivitat von EcoRII
Uber den B-Strang 1 (B1) und die a-Helix 2 (H2) reguliert wird. Deletion einer dieser beiden
Sekundarstrukturelemente schaltet die Autoinhibition vollstandig aus und fuhrt zu einer
konstitutiv aktivierten Restriktionsendonuklease, die jeden einzelnen EcoRII-Erkennungsort

spaltet.



Aufgabenstellung
1. Tag

Reinigung der Restriktionsenzyme EcoRIl und EcoRII-AH2
Experiment 1:  aus E.coli JM109 (pDK1, pQERII) und E.coli JM109 (pDK1, pQERII-AH2)
mittels Ni-NTA Affinitatstechnologie, Kontrolle der Reinigung tGber SDS-PAGE

Vergleichender Plaquetest mit dem Bakteriophagen T3 auf EcoRlII- bzw.

Experiment 2: _ o
EcoRII-AH2 exprimierenden E. coli-Stdmmen (in vivo-Restriktion)

2. Tag
Vergleichende Restriktionsspaltung von pBR322- und T3-DNA durch

Experiment 3: o
gereinigte Restriktionsenzyme EcoRII und EcoRII-AH2 (in vitro-Restriktion)

Auswertung der Experimente

Experiment 1: Bewertung des Reinigungserfolges der Proteine
Experiment 2: Auszahlung der T3 - Plaques und Berechnung des T3-Titers auf den beiden
E. coli-Stdammen

Experiment 3: Analyse der DNA-Spaltmuster

Versuchsablauf

Vorbereitung von Indikatorzellen fiir die Phagen-Titration und Praparation der
Zellpellets fiir die Proteinreinigung

Je 150 ml LB-Medium (+ 1 % Glucose, 50 pg/ml Kanamycin und 100 pg/ml Ampicillin)
werden mit einer Einzelkolonie von E.coli JM109 (pDK1, pQERII) und E.coli JM109 (pDK1,
pQERII-AH2) beimpft und bis zu einer ODggo von 0,5 bei 37°C geschittelt. Zur Induktion der
Expression der Gene, die fUr die Restriktionsendonukleasen kodieren, werden 0,2 mM IPTG
zugegeben und die Kulturen ber Nacht bei 18°C im Schittelwasserbad inkubiert. Fir die
Gewinnung der Zellpellets zur Proteinreinigung (Experiment 1) werden je 50 ml E.coli JM109
(pDK1, pQERII) und JM109 (pDK1, pQERII-AH2) Kulturen 20 min bei 4°C und 4500 rpm in
der Megafuge 1.0 R (Heraeus) zentrifugiert. Der Rest der Kulturen wird als Indikatorzellen fir
den Plaquetest (Experiment 2) genutzt. Ferner wird eine Ubernachtkultur von E.coli JM109

(pDK1) in LB-Medium (50 pug/ml Kanamycin) angezogen.



1.Tag

_ Reinigung der Restriktionsenzyme EcoRIl und EcoRII-AH2 aus E.coli
Experiment 1: j\1109 (pDK1, pQERII) und E.coli JM109 (pDK1, pQERII-AH2) mittels
Ni-NTA Technologie, Kontrolle der Reinigung uber SDS-PAGE

Die Restriktionsendonukleasen EcoRIl und EcoRII-AH2 wurden mit einem NH,-terminalen
Hisg -Tag in einem pQE-Vektor exprimiert. Dieser erlaubt die Aufreinigung der Proteine
mittels Ni-NTA (Ni-NTA=Nickel-Nitrilotriacetic acid) Technologie, einer Form der Affinitats-
Chromatographie. Sie beruht auf der spezifischen und reversiblen Bindung des Hisg -Tags
an Ni**-lonen, die an eine Matrix (NTA) gekoppelt sind (Abb. 2).
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Abb.2 Interaktion zwischen Aminosaure-Resten des His-Tags und der Ni-NTA Matrix (,The
QlAexpressionist* 2003)

Gebundene, unspezifische Proteine werden durch pH-Wert Verschiebung und Erhéhung der
Salzkonzentration im Wasch-Puffer entfernt. Die Ablésung der spezifischen Proteine erfolgt

durch kompetitive Verdrangung mittels Imidazol (100mM).

Proteinreinigung

Jede Gruppe reinigt zwei Restriktionsendonukleasen: 1. EcoRII (Wildtyp)
2. EcoRII-AH2 (Deletionsmutante)
1. Aufnahme der Zellpellets in je 500 pl Lysepuffer und Uberfilhrung in 1,7 ml Eppendorf-
gefalle. Zugabe von 60 ul Proteasehemmer (10x) und 6 ul Lysozym (50mg/ml)
2. 30 min Inkubation im Eisbad
(In der Zwischenzeit erfolgt die Vorbereitung der Ni-NTA Beads und der Proteingele)



Fir alle Zentrifugationsschritte Eppendorf Zentrifuge 5402 bzw. Hettich Zentrifuge
2404 benutzen, Proben immer im Eisbad bearbeiten.

Ni-NTA Beads

e 2 x 150 pl 50 %ige Ni-NTA Bead-Suspension zentrifugieren (2 min, 3000 rpm, +4°C),
Uberstand abnehmen und verwerfen

e Zugabe von je 1,5 ml sterilem Aqua bidest, Beads durch vorsichtiges Schwenken
resuspendieren, anschlieRend zentrifugieren (2 min, 3000 rpm, +4°C), Uberstand
abnehmen und verwerfen

e Zugabe von je 1,5 ml sterilem Lysepuffer, Beads durch vorsichtiges Schwenken
resuspendieren, anschlieRend zentrifugieren (2 min, 3000 rpm, +4°C), Uberstand
abnehmen und verwerfen. Vorgang ein weiteres Mal wiederholen und Eppendorf-
Gefale nach dem Zentrifugieren im Eisbad belassen. Den Uberstand erst kurz vor der

Verwendung der Beads abnehmen und verwerfen.

Proteingele (Augenschutz und Handschuhe tragen, Zugabe von TEMED unter dem

Abzug!) (es werden 2 Gele / Gruppe gegossen)

Trenngel (12%ig) Sammelgel (5%ig)

2 M Tris-Puffer (pH 8,8) 3,75 mi -

1 M Tris-Puffer (pH 6,8) - 1,3 ml
Acrylamid (40%ig) 6,1 ml 1,3 mi
SDS (10%ig) 200 pl 100 pl
APS (10%ig) 200 pl 100 pl
Aqua bidest 9,7 ml 7,2 ml
TEMED 40 pl 20 pl

(+ ~ 30ul Bromphenolblau-Lésung)

Weiterbearbeitung der Zellpellets

3. Ultraschall-Behandlung 4 x 12 s je Probe (je 1 min Pause zwischen den Intervallen)
Einstellungen: Timer: Hold
Duty Cycle: Constant
Output control: Stufe 6
Die Proben sollten nach der Ultraschallbehandlung deutlich diinnfliissiger sein!
4. Zentrifugation der Proben (30 min, 14000 rpm, +4°C)
5. Uberstande (Rohlysate) in neue EppendorfgefalRe pipettieren
6. Zugabe der Rohlysate zu vorbereiteten Beads, Eppendorfgefalie mit Parafiim

verschliel3en (~ 10ul Rohlysat fir Proteingel-Kontrolle im Eis/H,O-Bad stehen lassen)



30 min Inkubation im Eis/H,O-Bad im Kiihlraum

8. Zentrifugation der Beads (2 min, 3000 rpm, +4°C)

Pipettieren der Uberstande in frische EppendorfgefaRe, fiir Proteingel-Kontrolle im
Eis/H,O-Bad stehen lassen.

10. Zugabe von je 1,5 ml Lysepuffer zu den Beads (1. Waschschritt), durch vorsichtiges
Schwenken resuspendieren, anschlie®end zentrifugieren (2 min, 3000rpm, +4°C),
Uberstand in frische Eppendorfgefalie liberfiihren, im Eis/H,O-Bad stehen lassen.

11. Zugabe von je 1,5 ml Lysepuffer (2. Waschschritt), siehe Punkt 10

12. Zugabe von je 1,5 ml Waschpuffer (3. Waschschritt), siehe Punkt 10

13. Zugabe von je 1,5 ml Waschpuffer + 20 mM Imidazol (4.Waschschritt), sieche Punkt 10

14. Elution der Proteine mit je 3 x 100 ul Elutionspuffer (Waschpuffer + 100 mM Imidazol)
Eppendorfgefalle nicht schwenken, Beads nur vorsichtig resuspendieren und nach dem

Zentrifugieren Uberstinde abnehmen, siehe Punkt 10

Kontrolle der Protein-Reinigung iliber SDS-PAGE

Gel1 EcoRll Gel2 EcoRIl-A H2
Bahn Probe l HoO(ul) Bahn Probe pl HoO(ul)
1 Marker 8 - 11 Kontrolle 2 8
2 Kontrolle 2 8 12 Marker 8 -
3 Rohlysat 2 8 13 Rohlysat 2 8
4| oS0 2 8 14 |USn.beads| 2 8
5 Wasch1 15 - 15 Wasch1 15 -
6 Wasch3 15 - 16 Wasch3 15 -
7 Wasch4 15 - 17 Wasch4 15 -
8 Elution1 5 5 18 Elution1 10 -
9 Elution2 5 5 19 Elution2 10 -
10 Elution3 5 5 20 Elution3 10 -

e Zugabe von 10 pl Probenpuffer zu jeder Probe (aufer Marker), kurz mischen und
zentrifugieren.

e 3 min bei 72°C denaturieren, sofort auftragen

¢ Laufbedingungen: 1 x TG-Puffer, 90 V (Sammelgel), 120 V (Trenngel)

¢ Nachdem die Bromphenolblau-Front das Trenngel verlassen hat, Gele abnehmen,
fixieren und farben/entfarben:

e Fixieren:10 min in 10 % Essigsaure / 30% Ethanol

e Farben: 15 min in Coomassie-Farbeldsung

o Entfarben: abwechselnd je 20 min 10 % Essigsaure / 30% Ethanol und 10 min Aq bidest



Vergleich der Plattierungseffektivitit des Bakteriophagen T3 auf
Experiment 2: E.coli-Stammen mit und ohne EcoRII-R/M-System (in vivo
Restriktion)

Das Lysat des Bakteriophagen T3 wurde auf Wirtszellen angezichtet, die weder die E. coli
Dam- noch die E.coli Dcm-Methyltransferase enthalten. Ihre Genome sind demzufolge nicht
methyliert.

Vom Bakteriophagen-Lysat wird eine Verdiinnungsreihe bis 107 hergestellt (jeweils 0,5 ml
Bakteriophagen-Lysat + 4,5 ml Phosphatpuffer).

0,5ml 0,5ml

0,5ml
Phagenlysat

45m —p
Phosphatpuffer
10°

10" 10*

Von den unten angegebenen Verdinnungsstufen werden jeweils 0,5 ml mit 0,3 ml der
Indikatorzellen und 3 ml Deckagar (ca. 50 °C) gemischt und sofort auf LB-Agarplatten

gegeben. Es werden 2 Platten pro Verdunnungsstufe angelegt.

. E. coli E. coli E .coli
Verdiinnungsstufe
JM109(pDK1) JM109(pDK1, pQERII-WT) | JM109(pDK1, pQERII-AH2)

10"
10
107 X
10™ X
10° X
10°® X X
10”7 X X
10 X X
Titer

rel. e.o.p.

Zur Plaguebildung werden die Platten ca. 16 h bei 37 °C inkubiert.




2.Tag

Experiment 3: Vergleichende Restriktionsspaltung von pBR322- und T3-DNA
durch EcoRIl und EcoRII-AH2 (in vitro Restriktion)

Die T3 Phagen-DNA wurde aus einem hochtitrigen Phagenlysat durch Phenolextraktion und
anschlielendem CsClI-Dichtegradienten gereinigt. Die pBR322 Plasmid-DNA wurde aus
E.coli GM 1674 (pBR322) mittels Qiagen Maxiprap hergestellt.

Die gereinigten Enzyme (Eluate 2) werden jeweils unverdinnt, 1: 5 und 1: 10 verdinnt (in

Dialysepuffer) eingesetzt (sieche Tabelle).

Restriktionsansatz

Mastermix | Mastermix 2 [Enzym| H,0O
Bahn Ansatz (uD (1)) (ph (1))

1 pBR322/ Negativkontrolle 18 - - 2
2 pBR322/ Positivkontrolle Mval (10 U/ul) 18 - 1 1
3 pBR322/ EcoRlIl Eluat 2 (unverdiinnt) 18 - 1 1
4 pBR322/ EcoRII Eluat 2 (1:5) 18 - 2 -
5 pBR322/ EcoRlIl Eluat 2 (1:10) 18 - 2 -
6 pBR322/ EcoRII-AH2 Eluat 2 (unverdiinnt) 18 - 1 1
7 pBR322/ EcoRII-AH2 Eluat 2 (1:5) 18 - 2 -
8 pBR322/ EcoRII-AH2 2 (1:10) 18 - 2 -
9 Marker (Genaxxon, 1 kb ladder, 3ul) - - - -
10 [T3/ Negativkontrolle - 18 - 2
11 T3/ Positivkontrolle Mval (10 U/ul) - 18 1 1
12  [T3/ EcoRIl Eluat 2 (unverdiinnt) - 18 1 1
13 [T3/ EcoRIl Eluat 2 (1:5) - 18 2

14  |T3/ EcoRII Eluat 2 (1:10) - 18 2 -
15  |T3/ EcoRII-AH2 Eluat 2 (unverdiinnt) - 18 1 1
16 |T3/ EcoRIl-AH2 Eluat 2 (1:5) - 18 2 -
17  |T3/ EcoRII-AH2 2 (1:10) - 18 2 -
18  [Marker (Boe Il, 5 pl) - - - -

Mastermix 1 (10X) : Mastermix 2 (10x):

20pl 10x Uni-Puffer 20ul 10x Uni-Puffer
20pl pBR 322 (100 ng/ul) 20p! T3 DNA (100 ng/pl)
140 ul H,O 140 pl H,O

Die Restriktionsspaltansatze werden in einem Eisbad pipettiert. Nach einer Stunde
Inkubation bei 37°C werden die Proben (je 20 upl) mit 2 yl einer 10 x konzentrierten
Stoplésung gemischt, kurz abzentrifugiert und auf ein 0,7 % Agarosegel (5ul Serva DNA
Stain Clear G/100 ml Gelldsung) aufgetragen. Die elektrophoretische Auftrennung der DNA
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erfolgt in 0,5 x TBE-Puffer bei ca. 90 mA. Nach dem Lauf wird das Spaltmuster fotografisch

dokumentiert.

Auswertunqg der Experimente

Experiment 1: Bewertung des Erfolges der Proteinreinigung

Achten Sie auf Proteingehalt, Molekulargewicht und Reinheit der Enzyme.

Experiment 2: Phagentitrationstest

Die Plaques werden gezahlt, die Titer (Beispielrechnung s. unten) und die relative
Plattierungseffizienz berechnet.

Der Quotient aus dem Virustiter auf dem nicht-permissiven Stamm und dem Virustiter auf
dem permissiven Stamm wird als relative Plattierungseffizienz (rel. e. o. p.) bezeichnet

und ist Ausdruck fir die Restriktion der Virusvermehrung.

Beispiel zur Titerberechnung:

Verdunnung Platte Plaques pro 0,5 mi Wichtungsfaktor
10° 1 210 1
2 195 1
10 1 18 0,1
2 23 0,1
107 1 2 0,01
2 1 0,01
Summe 449 2,22
Titer (PFU/ml): 449 /(2,22 x 105 x0,5) = 4,04 x 107PFU/ml

Experiment 3: Analyse der DNA-Spaltmuster
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Anhang

Phosphatpuffer Na HPO4 x 2 Hy0 89¢g
KH PO, 39
Nall 5g
mit HZO auf 11 auffillen

LB-Flussigmedium Bacto-Tryptone 1049
Bacto-Hefeextrakt 59
NaCl 1049

LB-Platten

LB-Deckagar

Vor dem Autoklavieren 15 g Agar Noble zu einem Liter Medium zugeben.

Vor dem Autoklavieren 7 g Agar-Noble zu einem Liter Medium zugeben.

10 x TBE-Puffer Tris-Base 54 g
Borsaure 27549
0,5M EDTA pH 8,0 20 ml
mit HZO auf 11 auffillen

10 x TG-Puffer Tris-Base 15,19
Glycine 944
10% SDS 50 ml
mit HZO auf 11 auffillen

10 x Universalpuffer Kaliumacetat 1™

(pH 7.6) Tris-acetat 250 mM

Magnesiumacetat 100 mM
3-Mercaptoethanol 5mM
BSA 100 pg/ml

10 x Stoplésung Bromphenolblau 0,42 %
EDTA 200 mM
Ficoll 15 %

Lysepuffer NaH,PO, pH 8,0 50 mM
NaCl 300 mM
3-Mercaptoethanol 10 mM

Waschpuffer NaH,PO, pH 6,0 50 mM
NaCl 1™
Glycerol 10%
Triton X-100 0,1%
3-Mercaptoethanol 10 mM

Elutionspuffer

Imidazol 100 mM in Waschpuffer

Probenpuffer (3x) Tris-HCI pH 6,8 150 mM
SDS 6%
Bromphenolblau 0,3%
Glycerol 30%
DTT 100 mM

Dialysepuffer Tris/HCIl pH 7.6 20 mM
NaCl 200 mM
EDTA 1mM
DTT 1mM
Glycerin 50 %
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Elektronenmikroskopie

Arbeitsgruppe Bogner

Die Elektronenmikroskopie wurde erst in den 1930er Jahren von Helmut und Ernst Ruska
entwickelt. Die erste Beschreibung von Elektronen lieferte Thompson 1894. Einige Jahre
spater wurde von De Broglie der wellenartige Charakter von Elektronen beschrieben. 1926
konnte Busch nachweisen, dass Elektronen durch magnetische Linsen abgelenkt werden.

Ein Elektronenmikroskop ist ein Mikroskop, das das Innere oder die Oberflache einer Probe
mit Elektronen abbilden kann. Die Auflésung des Elektronenmikroskops ist durch die
Wellenlange begrenzt. Da schnelle Elektronen eine sehr viel kleinere Wellenlange als
sichtbares Licht haben, kann mit einem Elektronenmikroskop eine wesentlich héhere

Auflosung erreicht werden. Diese wird durch die Gleichung von De Broglie verdeutlicht:

h
A=

mXxv

Dies zeigt, dass je hoher die Geschwindigkeit v des Elektrons ist, desto kleiner die

Wellenlange A.

Aufbau eines Elektronenmikroskops

Die Elektronenquelle, die so genannte

A Ringelektrode Kathode, erzeugt im gluhenden Zustand
Elektronen, die durch einen Zylinder
gebindelt und in Richtung Anode
beschleunigt werden.
Man bendétigt darliber hinaus ein Vakuum-
system, da einerseits die Elektronenquelle
nicht zu sehr aufgeheizt wird und
andererseits es nicht zur Ablenkung der
Elektronen durch Kollision mit Luftmolekullen
Projektionslinsen kommt.
Die magnetischen Linsen haben die gleiche
Funktion wie die eines Lichtmikroskops.

Kondensorlinse
.. Kondersorblende

Objektivlinse

Vakkuum

Leuchtschirm
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Bei der Elektronenmikroskopie gibt es unterschiedliche Methoden, die Proben sichtbar zu
machen. Eine der am haufigsten verwendeten Methoden ist die Negativkontrastierung.
Hierbei wird nicht das Objekt gefarbt, sondern nur die Umgebung, so dass das Objekt, die
vom Kontrastierungsmittel ausgeschlossenen Bereiche umfasst.

Bei der konventionellen Elektronenmikroskopie werden Proteine, die aus Atomen mit
niedriger Ordnungszahl bestehen und damit Elektronen schlecht streuen, mit einem Material
kontrastiert, das aus Atomen mit hoher Ordnungszahl, die Elektronen sehr gut streuen,

bestent. Das Objekt hat nun genigend hohen Kontrast flr die Abbildung im

Elektronenmikroskop. Als Kontrastierungsmittel werden Schwermetallsalze verwendet

(Uranylacetat, Phosphorwolframsaure).

Partikel

Kohlefilm| |

Im Praktikum wird eine Negativkonstrastierung von nichtpathogenen Influenzaviren und ein

Immunostaining des humanen Cytomegalievirus durchgefiihrt.

Influenzaviren

Influenzaviren gehoren zur Familie der Orthomyxoviridae. Das Genom besteht aus acht

Segmenten einzelstrangiger RNA mit negativer Orientierung.

Aufbau von Influenzaviren -ssRNA
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Das Nukleokapsid bestehend aus der RNA, die von dem Kapsidprotein umgeben ist. An
5°Ende der RNA befindet sich die RNA-Polymerase (PB1, PB2 und PA). Das Nukleokapsid
ist umgeben von der Hiuille, die die viralen Glykoproteine Hamagglutinin und Neuraminidase
sowie den lonenkanalbildner M2 enthalt. Zwischen Nukleokapsid und Hiille befindet sich das

Matrixprotein M1.

Humanes Cytomegalievirus

Das humane Cytomegalievirus gehort zur Familie der Herpesviridae und zur Unterfamilie der
R-Herpesviren. Das Genom besteht aus einer doppelstrangigen DNA und hat eine Grolie
von 230 kb.

Aufbau von HCMV

Capsid

dsDNA } Nucleocapsid
Tegument

Lipidmembrane
Glycoproteincomplex |

Glycoproteincomplex Il

- Glycoproteincomplex IlI

Die doppelstrangige DNA befindet sich in dem ikosaedrischen Kapsid. Dieses ist umgeben
von einer Proteinschicht, dem so genannten Tegument. Daran schlief3t sich die Lipidhtlle mit

den eingelagerten viralen Glykoproteinen an.
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Praktikumsaufgabe

1.  Negativkontrastierung von Influenzenzaviren

40 ul Virussuspension auf einen Streifen Parafilm geben
kohlebedampftes Grid auf die Suspension legen (Kohle zeigt nach unten)
Inkubation: 5 min

Grid auf einen Tropfen mit Wasser od. HEPES-Puffer pH 7.5 Uberflihren
Grid auf einen Tropfen 4% Uranylacetat legen

Inkubation: 20 s

Grid auf ein nasses Filterpapier legen und trocknen lassen

-~ 0 a0 T @

Q@

2. Immunstaining von HCMV

Verwendet werden mit Kohle-bedampfte Nickelgrids.

1. 40 pl Virussuspension 5 min

2. 1% BSA in Puffer (Tris, HEPES) 15 min
3. 1. Antikorper (gegen gB) 45 min
4.  waschen mit Puffer 3 x 1 min
5. 2. Antikorper (anti-Maus Gold-konj.) 45 min
6. waschen mit 1%BSA in Puffer 2x 1 min
7. waschen mit Puffer 3x 1 min
8.  waschen mit Aqua bidest. 1 min
9. 1% Glutaraldehyd in Puffer 2 min
10. 4% Uranylacetat 20s

11. Grid auf nasses Filterpapier legen, trocknen
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Die Proben werden am Elektronenmikroskop des Robert-Koch-Instituts (Technai mit CCD-
Kamera) bei einer konstanten Spannung von 120 kV angeschaut. Die Grids werden auf

einem Probenhalter fixiert und anschliefend in den Strahlengang eingeschleust.

Technai 9
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Immuncytochemische Analyse von herpesviralen Infek-

tionen und Detektion von Apoptose

Arbeitsgruppe Schénrich

Einleitung

Eine interessante Forschungsrichtung an der Nahtstelle zwischen Immunologie und Virologie
beschaftigt sich mit den Mechanismen, durch die Viren sich dem Zugriff des Immunsystems
entziehen (virale Immunevasion). Insbesondere die grole DNA-Viren wie die Mitglieder der
Herpesvirus-Familie kodieren fur zahlreiche Proteine, die in die Auseinandersetzung mit den
Immunzellen des Wirtes eingreifen. Dabei kdnnen die Immunzellen (z. B. Dendritische

Zellen) selbst von bestimmten Herpesviren infiziert werden (virale ,Counterattack®).

Fir den Nachweis der Herpesviren missen virale Proteine durch immunhistochemische
Methoden angefarbt werden. Die im Rahmen von Infektionen mit Herpesviren synthetisierten
viralen Proteine werden entsprechend dem Zeitpunkt eingeteilt, zu dem sie nach der Infek-
tion in der Zelle gebildet werden. Die sehr friihen oder immediate early (IE)-Proteine entste-
hen zuerst und zwar unabhangig von der Neusynthese anderer Virusprodukte. Danach fol-
gen zeitlich die delayed early (E)-Proteine; sie sind von der Anwesenheit der IE-Proteine
abhangig. Die spaten oder late-Proteine werden gegen Ende des Replikationszyklus gebildet
und stellen Strukturproteine dar, die am Aufbau der Virionen wesentlich beteiligt sind. Als
Konsequenz der Virusinfektion kébnnen Immunzellen physisch eliminiert werden, indem der
programmierte Zelltod (Apoptose) Uber verschiedene Mechanismen induziert wird. Daraus
kann eine lokale oder systemische Immunsuppression resultieren, die dem Virus eine unge-

hinderte Replikation ermdglicht.

Aufgabenstellung

In diesem Praktikumsteil soll der immunhistochemische Nachweis von herpesviralen Protei-
nen durchgeflihrt werden (Experiment 1). Auflerdem soll Apoptose in infizierten Zellen

detektiert werden (Experiment 2).
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Experiment 1: Imnmuncytochemische Analyse von infizierten Zellen

Material

24-Loch-Platten (enthalten Deckglédschen mit einem einschichtigen Rasen von HCMV-
infizierten HEF-Zellen)

PBS-Ldsung

4 % Paraformaldehyd-L6sung

1 % Triton-Lésung

5 % Glycerol-Lsg.

Lésungen mit primaren Antikdrpern gegen |IE-Protein, Early-Proteine und Late-Proteine

Lésungen mit sekundaren Antikérpern

Vorbereitung
Ein Streifen Parafilm wird auf der Laborbank mit Tesafilm befestigt. Darauf wird ein Tropfen

PBS gegeben. Daneben werden weitere Tropfen mit folgenden Lésungen platziert (Reihen-
folge beachten): 4 % PFA-Lsg., PBS, 1 % Triton-Lsg., PBS, PBS, PBS, PBS. Eine zweite

Tropfenreihe wird darunter in der gleichen Weise aufgebaut.

Wichtig: Deckglaschen sind sehr zerbrechlich; die Seite des Deckglaschens mit dem infi-

zierten Zellrasen darf nie austrocknen!

Durchfiihrung

Nimm die Deckglaschen mit der Pinzette und lege sie in den ersten Tropfen (PBS; Seite
mit dem Zellrasen nach unten) der ersten bzw. zweiten Reihe

Warte 30 Sek.

Entferne schnell die restliche Flissigkeit auf den Deckgldschen und lege sie in den
nachsten Tropfen (4 % PFA-Lsg.) der ersten bzw. zweiten Reihe

Warte 3 Min.

Entferne schnell die restliche Flissigkeit auf den Deckglaschen und lege sie in den
nachsten Tropfen (PBS) der ersten bzw. zweiten Reihe

Warte 30 Sek.

Entferne schnell die restliche Flissigkeit auf den Deckglaschen und lege sie in den
nachsten Tropfen (1 % Triton-Lsg.) der ersten bzw. zweiten Reihe

Warte 4 Min.

Entferne schnell die restliche Flissigkeit auf den Deckgldschen und lege sie in den
nachsten Tropfen (PBS-Lsg.) der ersten bzw. zweiten Reihe

Warte 10 Sek.
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e Entferne schnell die restliche Flussigkeit auf dem Deckglaschen und lege sie in den
nachsten Tropfen (PBS) der ersten bzw. zweiten Reihe

e Warte 30 Sek.

o Entferne schnell die restliche Flissigkeit auf dem Deckglaschen und lege sie in den
nachsten Tropfen (PBS) der ersten bzw. zweiten Reihe

e Warte 1 Min.

e Entferne schnell die restliche Flissigkeit auf dem Deckglaschen und lege sie in den letz-
ten Tropfen (PBS) der ersten bzw. zweiten Reihe

e Bereite eine feuchte Kammer vor (Petrischale mit einem feuchtem Filterpapier) und lege
einen Objekttrager hinein

e Lege ein Deckglaschen mit dem Zellrasen nach oben auf den Objekttrager (Der Zell-
rasen darf nicht austrocknen!)

o  Gib 40 pl der Lsg. mit dem primaren Antikérper darauf

e Inkubiere fur 45-60 Min. bei 37°C

e Bereite zwei neue Reihen mit jeweils 4 Tropfen PBS-Lsg. vor

¢ Nimm die Deckglaschen und wasche sie in den PBS-Tropfen (Verweildauer im PBS: 10
Sek., 30 Sek., 2 Min., 5 Min.)

o Plaziere die Deckglaschen mit dem Zellrasen nach oben auf dem Objekttrager (Der Zell-
rasen darf nicht austrocknen!)

o Gib 40 pul der Lsg. mit dem sekundaren Antikérper darauf

e Inkubiere fir 45-60 Min. bei 37°C

e Nimm die Deckglaschen und wasche sie in den PBS-Tropfen (Verweildauer im PBS: 10
Sek., 30 Sek., 2 Min., 5 Min.)

e Nimm neue Objekttrager und gib 2 Tropfen 5 % Glycerol-Lsg. darauf. Plaziere die Deck-
glaschen mit dem Zellrasen nach unten in die Tropfen.

e Nun kdnnen die Zellrasen mit dem Immunfluoreszenz-Mikroskop analysiert werden (Vor-
sicht: Die Deckglaschen konnen sich leicht auf dem Objekttrager bewegen, so dass die

Zellen abgerieben werden!)

Experiment 2: Detektion von Apoptose in Zellen

Einleitung

Zellen werden hauptsachlich durch zwei Wege aus dem lebenden Organismus eliminiert:
Nekrose und Apoptose.
Zellen, die durch aulere Einflusse, wie zum Beispiel durch mechanische Verletzung verletzt

werden, sterben durch Nekrose. Hierbei wird die Cytoplasmamembran zerstort und die Zelle
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entlasst das Zellinnere mit Organellen und Enzymen in die Umgebung. Dies fihrt zu lokalen

Entziindungsreaktionen im Organismus.

Im Gegensatz dazu handelt es sich bei der Apoptose um ein streng regulierten program-
mierten Zelltod, der nur in der betroffenen Zelle ablauft. Es ist ein Vorgang, der fur die Ent-
wicklung und Aufrechterhaltung eines vielzellig lebenden Organismus essentiell ist. Wahrend
der Apoptose kommt es zu vielfaltigen zelluldren Anderungen, die auch im Laufe dieses

Praktikums nachgewiesen werden sollen:

e Anderung in der Symmetrie der Lipiddoppelschicht der Membran
e Kondensation des Chromatins

e Abschniirung von Vesikeln (blebbing)

o DNA Fragmentierung

Apoptose kann Uber zwei Wege eingeleitet werden: von auflen durch Immunzellen, extrin-

sischer Weg, oder aufgrund von zellinternen Prozessen, intrinsischer Weg.

Der extrinsische Weg wird meistens von Immunzellen ausgeldst, die mit ihrem Todes-Ligan-
den (Fas-Ligand) an den Rezeptor (Fas-Rezeptor) auf der betroffenen Zelle binden. Dadurch
kommt es zur Trimerisierung des Rezeptors und zur Bildung des DISC-Komplexes (death-
inducing signaling complex). Hierbei handelt es sich um mehrere Caspasen, die dann
kaskadenartig final zur Aktivierung einer DNase und anderen Effektormechanismen fihrt.

Dies flihrt schlieBlich zur Fragmentierung der DNA.
Der intrinsische Weg wird durch die Freisetzung von Cytochrom C aus den Mitochondrien ins
Cytoplasma der Zelle eingeleitet. Hierbei kommt es wieder zur Aktivierung von Caspasen,

die wiederum zur Aktivierung von DNasen flhren.

Viren, wie zum Beispiel das Herpes-simplex-Virus (HSV), kdnnen zelltypabhangig die Induk-

tion von Apoptose verhindern oder diese gezielt induzieren.
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Aufgabenstellung

In diesem Teil des Praktikums werden Zellen mittels verschiedener Stimuli fir Apoptose
sensibilisiert und anschlielfend lichtmikroskopisch, fluoreszenzmikroskopisch und mittels

Agarose-Gelelektrophorese analysiert.

Als Stimuli dienen zum einen die Infektion mit dem HSV, die Zugabe des Fas-Liganden
CD95L und die Zugabe des Proteinkinaseinhibitors Staurosporin (STS).

Die Einleitung der Apoptose Uber den extrinsischen Weg wird durch Zugabe des Fas-Ligan-
den (CD95L) zu den Zellen ausgeldst. Dieser bindet spezifisch an den Fas-Rezeptor (CD95)
der Zelle und induziert in dieser Apoptose. Der intrinsische Weg wird durch die Zugabe von

Staurosporin eingeleitet.

Frih zu Beginn der Apoptose kommt es zur Anderung in der Asymmetrie der Cytoplasma-
membran. Hierbei werden Phosphatidylserin-Molekule von der Innenseite der Membran auf
die Aulenseite transloziert (flipping). Annexin V bindet calciumabhangig spezifisch an
Phosphatidylserine. Durch Kopplung von Annexin V mit dem Fluorophor FITC (Fluorescein-
Isothiocyanate) kdnnen apoptotische Zellen im Fluoreszenzmikroskop in diesem Praktikum
nachgewiesen werden. Annexin V bindet nicht an normal intakte Zellen. Um nekrotische
Zellen zu identifizieren, werden die Zellen zusatzlich zur Annexin V Farbung mit Propidium-
iodid angefarbt. Propidiumiodid interkaliert in die DNA. Bei Zellen, die sowohl positiv fir

Annexin und Propidiumiodid sind, handelt es sich um nekrotische Zellen.

Darlber hinaus soll die Fragmentierung der DNA in apoptotischen Zellen im Agarosegel

sichtbar gemacht werden.

ACHTUNG!

Ethidiumbromid und Propidiumiodid sind kanzerogene Stoffe, die in die DNA interkalie-

ren. Beim Arbeiten mit diesen Stoffen sind Handschuhe zu tragen!

Die 24-well-Platten enthalten infektiose HSV-Partikel! Deshalb sind die Platten nur unter

der Sterilbank zu 6ffnen und ansonsten geschlossen zu halten!

Generell sind beim Arbeiten Handschuhe und Kittel zu tragen!!!
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Versuchsdurchflihrung

Analyse der Morphologie und Membranintegritat

Alle Beobachtungen werden in das beigefiigte Arbeitsblatt eingetragen!

Co
24-well-Platte 1

HSV
2

Fas
3

HSV+
Fas
4

STS

HSV+
STS

1. Kontrolle

2. Trypanblaufarbung

3. AnnexinV/Propidiumiodid
Farbung

4. DNA-Lyse

Lichtmikroskopische Betrachtung

> Reihe 1 betrachten

> Reihe 2: Zugabe 50 ul Trypanblau (unter Sterilbank!) und Betrachten

Arbeiten unter der Sterilbank

Reihe 3-4: Medium absaugen

Platte 15 min in Kiihlschrank

YV V V V V V V

Reihe 3: Zugabe von 200 pl Annexinpuffer
Reihe 4: Zugabe von 300 pl Lysispuffer
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Reihe 4: zidhes Lysat in beschriftete Eppendorftube lberflihren

Reihe 3: Absaugen Annexin-V-Ldsung und Zugabe 200ul Annexinpuffer

Reihe 3: Absaugen von Annexinpuffer und Zugabe von 100 pyl Annexin-V-Lésung




Auswertung am Fluoreszenzmikroskop

> Reihe 3: Annexin-V Farbung
> Reihe 3: unter Sterilbank Zugabe von 10 pl Propidiumiodidlésung

Unter dem Fluoreszenzmikroskop wird die Membranintegritat (Annexin-V; Reihe 3) und die
Kernmorphologie (Propidiumiodide; Reihe 3) lebender, friih- und spat-apoptotischer und

HSV-infizierter Zellen verglichen.

Analyse der Fragmentierung der DNA im Agarosegel

GieRBen des 1 % Agarosegels

> Aufkochen der 1 % Agarosegellésung in Mikrowelle (standige Kontrolle, dass es nicht
tiberkocht!)

VORSICHT HEISS!

Flasche mit Handschuhen anfassen und zum Abkuhlen draufen stehen lassen
Gelkammer abkleben mit Autoklavierband und Spacer einsetzen

Ausgekiihlte Agaroseldsung eingielsen

Ausharten lassen

100 ul Ladepuffer zu Lysat geben

1,5 ul DNA-Marker in 1. Geltasche pipettieren

je 20 ul in Geltasche pipettieren; ACHTUNG viskoses Lysat mit DNA-Faden!
Gel bei 100 V laufen lassen (30-45 min)

Gel fur 10 min in Ethidiumbromidbad farben

mit Handschuhen Gel unter UV-Licht anschauen

YV V.V V V V V V V V VY
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Co

HSV-F

Fas

HSV+Fas

STS

HSV+STS
6

Generelle

Morphologie

Trypanblaufarbung

Annexin V-Farbung

Propidiumiodid-
farbung

DNA-Analyse
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Abkiirzungen

E: Early-Proteine

HCMV: Humanes Cytomegalievirus
HEF: Human embryonic fibroblasts
HSV-1: Herpes simplex Virus Typ 1
IE: Immediate Early-Proteine

L: Late-Proteine

PBS: Phosphate Buffered Saline
PFA: Paraformaldehyd

SDS: Natriumdodecylsulfat

STS: Staurosporin

TAE: Tris/Acetat/EDTA Elektrophorese-Puffer
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Zellkulturen

C. Priemer

Einleitung

Die Kultivierung animaler Zellen gehdrt zu den Standardmethoden in der Zell- und Moleku-

larbiologie und ist ein wichtiges Hilfsmittel in der animalen Virologie.

Zellkulturen stellen im Gegensatz zu anderen Kultivierungssystemen ideale, relativ einheitli-
che Wirtssysteme fur die Arbeit mit Viren dar. Sie bieten die Grundlage fur die Isolierung und
Vermehrung von Viren und werden in der Routinediagnostik von Viruskrankheiten sowie zur

Entwicklung, Herstellung und Priifung von Impfstoffen verwendet.

Definition wesentlicher Termini

Zellkultur wird die Vermehrung und das Wachstum von Zellen in vitro genannt. Die Zellen
organisieren sich hierbei nicht mehr in Gewebe. Eine durch Trypsinbehandlung eines geeig-
neten Gewebes bereitete Zellsuspension wird in Petrischalen oder Kulturflaschen Uberfiihrt.
Die Zellen kdnnen an der Oberflache anhaften und sich durch Teilung zu einem einschichti-
gen Zellrasen (Monolayer) vermehren oder durch standige Bewegung in Suspension gehal-
ten werden. Sind die Zellen durch Teilung so dicht gewachsen, dass sie einander berihren,

endet das Wachstum durch Kontaktinhibition.

Passagieren: Transferieren von Zellen von einem Kulturgefald in ein anderes, wobei eine
Verdiinnung der Zellen erfolgt und die Zellen sich erneut teilen kdnnen. Bei Monolayer-Kultu-
ren erfolgt die Passage durch Abldsen von der Oberflache und Vereinzeln der Zellen mittels

einer Trypsin-Versen-Behandlung.
Zellkulturmedien: Fir die isolierten Zellen muss unter in vitro-Bedingungen ein Milieu

geschaffen werden, das eine optimale Proliferation erlaubt. Medien werden aus biologischen

Bestandteilen und gepufferten physiologischen Salzldsungen zusammengesetzt.
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Salzlésungen dienen der Erhaltung physiologischer Bedingungen und des pH-Wertes. Die
biologischen Bestandteile beinhalten bei den synthetischen Medien chemisch definierte
Substanzen, die fur das Zellwachstum essentiell sind. Die Medien werden mit Serum
supplementiert, um ein optimales Wachstum Uber langere Zeit zu ermdglichen. Durch

Zugabe von Antibiotika sollen Bakterienkontaminationen vermieden werden.

Primarkultur

Kulturen aus Zellen, Geweben oder Organen, die einem Organismus entnommen wurden.

Zellinien

Eine Primarkultur besteht aus einer Vielzahl verschiedener Zelltypen. Durch Klonierung kann

man aus einzelnen Zellen homogene Zellinien gewinnen.

!
diploide Zellinie — — permanente Zellinie
begrenzt haltbar, 75 % der Zellen unbegrenzte
besitzen gleichen Karyotyp wie Subkultivierung

normale Zellen der Spezies

Suspensionskulturen: Zellen flotieren im Nahrmedium.

Oberflachenkulturen: Zellen wachsen auf einer Unterlage.

Nach der Morphologie unterscheidet man:

— epitheloid wachsende Zellen; das sind mosaikartige Schichten mit wenig Interzellular-
substanz und

— fibroblastoid wachsende Zellen; sie wachsen spindelférmig und faserbildend.
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Aufgabenstellung

Aus einer Kulturflasche mit konfluent gewachsenen humanen embryonalen Lungen-
fibroblasten soll eine neue Subkultur mit 800 000 Zellen in einer Mikrogewebekulturflasche

(25 cm? Wachstumsflache) angelegt werden.

1. Herstellen einer Zellsuspension

Zellinie: Fi 301; humane embryonale Lungenfibroblasten; diploid; bis zu 30 Passagen

moglich.

Methode: Passagieren der Zellen mit Trypsin-EDTA-L6sung. Es ist darauf zu achten, dass
die Zellen nicht zu lange mit der Trypsin-EDTA-L6sung in Kontakt bleiben. Lange Einwirk-
zeiten kénnen die Lebensfahigkeit der Zellen irreversibel schadigen. Die Temperatur fir die
Trypsineinwirkung ist bei 37 °C optimal, deshalb sollte die Lésung vorgewarmt werden.

Der Trypsinierungsprozess sollte unter dem Mikroskop beobachtet werden. Eine optimale
Einwirkzeit ist gegeben, wenn die Mehrheit der Zellen sich von der Unterlage abgehoben hat

und abgerundet in der Trypsinierungslésung schwimmt.
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Material: 1 Mikroflasche mit konfluent gewachsenen Fibroblasten
Trypsin-EDTA-L6sung 37 °C (STV-Lésung)
PBS
Vorgewarmtes frisches Medium (MEM, 7,5 % fotales Kalberserum,
Antibiotikazusatz)
Pipettierhilfe
Sterile Pipetten

Sterile Kulturflasche

Durchfiihrung

— Verbrauchtes Kulturmedium abgiel3en.

Zellen mit PBS waschen, PBS abgiel3en.

1 ml STV-Losung in die Kulturflasche geben, nicht direkt auf den Zellrasen pipettie-
ren.

Nach kurzem Schwenken unter Befeuchtung des Zellrasens mit STV-Losung diese
abgielRen.

- Zellen bei 37 °C fur 1-2 Minuten inkubieren.

AnschlieRend mikroskopische Beobachtung des Ablésens des Zellrasens.
Resuspendieren der Zellen durch Zugabe von 5 ml Medium.

Abspllen der Zellen von der GefalRwand und Vereinzeln durch wiederholtes Pipettie-
ren.

0,1 ml Zellsuspension fir die Zellzahlbestimmung entnehmen.

2. Zellzahlbestimmung

Fir ein optimales Wachstum spielt die anfanglich zugesetzte Zellzahl eine entscheidende
Rolle. Zu dinn ausgesate Zellen wachsen nur langsam, zu dicht ausgesate Zellen missen
zu oft subkultiviert werden, wobei jede Subkultivierung fur nicht transformierte Zellinien die

Gesamtlebensdauer der Zellinie verkurzt.
Mittels Typanblau-Anfarbung kann man zwischen lebenden und toten Zellen unterscheiden.

Der Test beruht darauf, dass lebende Zellen Trypanblau nicht aufnehmen, wahrend sich bei

toten Zellen sowohl Cytoplasma als auch Kern anfarben.
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Soll eine Zellzahlung wiederholt werden, muss der Testansatz neu gemischt werden, da sich
bei mehr als finf Minuten Inkubationszeit des Testansatzes die Zahl der angefarbten Zellen

stark erhéhen kann. Trypanblau wirkt cytotoxisch.

Material: Hamocytometer (FUCHS-ROSENTHAL)
Zellsuspension
Trypanblau-Lésung (0,2 %-ig)
Pipetten 1 ml
Mikroskop

Durchflihrung:

— Deckglas und Oberflache der Zahlkammer reinigen.

— Rander der Zahlkammer leicht anfeuchten, Deckglas auf die Zahlkammer schieben. Das
Erscheinen der ,Newtonringe® zeigt an, dass das Deckglas richtig angebracht und die
Tiefe der Zahlkammer richtig eingestellt ist.

— Reagenzglas mit 0,9 ml Trypanblau-Ldsung vorbereiten.

— 0,1 ml gut durchmischte Zellsuspension in Trypanblau-Losung pipettieren, gut durch-
mischen.

— Suspension in Zahlkammer durch Ansetzen der Pipette an die Kante der Zahlkammer
fullen, wobei Kapillarkrafte diese selbst in den Zwischenraum zwischen Deckglas und
Kammer saugen; auf keinen Fall Gber- oder unterfillen.

— Zellen unter dem Mikroskop auszahlen. Dabei ist darauf zu achten, dass Zellen, die auf
den Linien liegen, nicht doppelt gezahlt werden. Dies ist zu vermeiden, indem nur solche
Zellen gezahlt werden, die oben und links vom Betrachter auf den Linien liegen.

— Alle 16 grofRen Quadrate auszahlen.

— Berechnung der Zellzahl / ml Zellsuspension: Gezahlte Zellen x Kammerfaktor (312) x

Verdunnungsfaktor (10).
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. Anlegen einer Subkultur mit 800 000 Zellen

Berechnung der Zelleinsaat:
Gegeben: Gezahlte Zellzahl / ml.
Gewdlnscht: 800 000 Zellen / x ml.

Zellzahl (gezahlt) : gewlnschte Zellzahl = 1 ml : x.

Gewinschte Zellzahl
Zelleinsaat (ml) =

Zellzahl (gezahlt)

Berechnete Zelleinsaat in neue Kulturflasche pipettieren.

Kultur mit frischem Kulturmedium (ca. 5 ml) erganzen.

. Auswertung

Nach 4 (bzw. 3) Tagen mikroskopische Beurteilung der angelegten Zellkultur anhand der
Ausbreitung der Zellen auf der Wachstumsflache.

Ermittlung des Zellwachstums nach 4 (bzw. 3) Tagen durch Bestimmung der Zellzahl pro
Kulturflasche. Der Quotient gezahlter Zellen durch die Zellzahl der Einsaat ergibt eine

quantitative Aussage Uber das Zellwachstum:

Zellwachstum = ——-----

Einsaat
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Virusdiagnostik

Arbeitsgruppe Diagnostik — J. Hofmann

Die Diagnostik viraler Infektionserreger spielt eine wesentliche Rolle bei der Pravention und
Therapie von Infektionskrankheiten. Neben vielen lange bekannten humanpathogenen Viren
(z.B. Herpes- oder Hepatitisviren) treten neue (z.B. SARS-Coronavirus) oder sogenannte
.reemerging“ Viren (z.B. Vogelgrippe-Virus H5N1) im diagnostischen Alltag auf. Die hohe
Mutationsfreudigkeit vieler dieser Viren kann zum Auftreten neuer Geno- oder Subtypen
fuhren, die mdglicherweise mit den gangigen praventiven und therapeutischen MaRnahmen
nicht mehr bekampft werden kénnen. Das rechtzeitige Erkennen sowohl der Erreger als auch
deren Veranderungen stellt die groRe Herausforderung der modernen virologischen
Diagnostik dar. Heute steht nicht mehr nur der alleinige Nachweis des Erregers im
Vordergrund, sondern der behandelnde Arzt méchte auch wissen, wie hoch die Viruslast bei
seinem Patienten ist, welcher Subtyp vorliegt, wie er therapieren kann und am besten auch
noch eine Abschatzung des therapeutischen Erfolgs. Insbesondere durch die zuletzt
genannten Forderungen hat sich das Spektrum der virologischen Diagnostik in den letzten
Jahren verandert. So ist die Methode der Isolation infektidser Viren aus Patientenmaterial
(Koch’'sche Postulate!), die bei vielen Fragestellungen den Goldstandard darstellt, aus
zahlreichen Labors verschwunden bzw. spielt nur noch eine untergeordnete Rolle.
Sensitivere und schnellere Methoden wie Nukleinsaureamplifikationstechniken (NAT) treten
trotz eingeschrankter Aussagekraft an die Stelle der Virusisolation. Klassische serologische
Nachweisverfahren, wie die Komplementbindungsreaktion, Hamagglutinations- und -
hemmteste oder auch Immunfluoreszenzteste werden aufgrund ihrer teilweise limitierten
Aussagekraft und des hohen subjektiven Faktors beim Abarbeiten und Ablesen durch
automatisierbare Verfahren wie Enzymimmunoassays ersetzt. Auf der anderen Seite
nehmen NAT einen immer breiter werdenden Raum in der Diagnostik ein, da sie nicht nur
schnelle Hinweise liefern kénnen, sondern auch die Basis fiir viele weitere Untersuchungen

wie Geno- und Serotypisierungen oder Resistenztestungen darstellen.

Die zweite grolte Herausforderung an die Laboratoriumsmedizin ist die Arbeit auf der Basis
standardisierter Verfahren und Vorschriften. In den letzten Jahren sind Qualitdtsnormen
sowohl fur Europa als auch fur die jeweiligen Lander definiert worden. Viele virologische

Labors in Deutschland arbeiten bereits nach diesen Qualitatsrichtlinien und haben sich
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akkreditieren lassen. Dies bedeutet einen grofien zeitlichen und finanziellen Aufwand fiir das

Labor, flhrt aber gleichzeitig zu einer qualitativ hochwertigen und zuverlassigen Diagnostik.
Sie werden wahrend lhres Praktikums einen Rundgang durch die diagnostische Abteilung

des Instituts machen und dabei die modernen Methoden der Diagnostik und die Eckpfeiler

des Qualitdtsmanagements kennenlernen.
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Antivirale Chemotherapie

Arbeitsgruppe Diagnostik — H. Heider

Wirkungsmechanismen von Antiherpetika

Die antivirale Selektivitat der Nukleosidanaloga beruht auf ihrer Phosphorylierung durch her-
pesvirale Nukleosidkinasen und, nach der weiteren Phosphorylierung zum Triphosphat durch
zellulare Kinasen, auf der spezifischen Hemmung der viralen DNA-Polymerase mit oder
ohne Einbau in die DNA.

Herpes-simplex-Virus Typ1 (HSV-1) induziert eine Desoxypyrimidinkinase, die — im
Gegensatz zu analogen zelluldaren Enzymen — Bromvinyldesoxyuridin (BVDU) zum Mono-
und Diphosphat phosphoryliert. Nur der letzte Phosphorylierungsschritt zum Triphosphat
erfolgt durch zellulare Kinasen. BVDU-Triphosphat wird durch die HSV-1-DNA-Polymerase
in die virale DNA eingebaut, welches wiederum eine Hemmung der Expression ,spater®

mRNA und Proteine zur Folge hat.

Aciclovir (ACV) wird nur bis zum Monophosphat kinasiert, zellulare Enzyme katalysieren die
weiteren Schritte. Der Einbau von ACV-Triphosphat in die DNA flihrt wegen des Fehlens
einer 3*-OH-Gruppe zum Kettenabbruch, und es entsteht ein stabiler ternarer Komplex mit

der viralen DNA-Polymerase, deren Funktion dadurch irreversibel gehemmt wird.
Die Herpes-simplex-Virus Typ 2 (HSV-2) induzierte Kinase phosphoryliert BVDU nur zum
Monophosphat. Daher wird HSV-2 durch BVDU nicht gehemmt. Die Wirkung von ACV gegen

HSV-2 ist analog der gegen HSV-1.

Varicella-Zoster-Virus (VZV) induziert ebenfalls eine Desoxynukleosidkinase. Die Wir-

kungsprinzipien der Nukleosidanaloga BVDU und ACV sind wie flir HSV-1 beschrieben.
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Zytomegalievirus (CMV) wird nicht durch BVDU und kaum durch ACV gehemmt. Ganciclo-
vir (GCV) ist eine Weiterentwicklung von ACV mit einem breiteren Wirkungsspektrum.
Wegen seiner relativ hohen Toxizitat ist die Anwendung auf schwere CMV-Infektionen
beschrankt. GCV wird in CMV-infizierten Zellen selektiv kinasiert. An der Phosphorylierung
zum Monophosphat ist eine viruscodierte Phosphotransferase (UL 97) geringer
Substratspezifitat beteiligt. GCV-Triphosphat hemmt die virale DNA-Polymerase und wird in
die Virus-DNA inkorporiert.

Foscavir (PFA) ist ein Pyrophosphatanalogon, das die DNA-Synthese nach dem Prinzip der
Produkthemmung inhibiert. Es hat ein relativ breites antivirales Spektrum, wird jedoch wegen

seiner Nephrotoxizitat nur bei schweren CMV-Infektionen eingesetzt.

Antiherpetika-Resistenzen

Far HSV-1, HSV-2 und VZV gilt, dass Resistenz gegen die Nukleosidanaloga zu etwa 90 %
durch Mutationen im Desoxypyrimidinkinase-Gen bedingt ist. Deletionen fihren zum Ausfall
dieses Virusproteins, Punktmutationen zu einer geringeren Phosphorylierung der Antiherpe-
tika. Die selteneren Mutationen im DNA-Polymerase-Gen erhdhen die Diskriminierung des

Enzyms gegen diese Substratanaloga.

Mutationen in den Genen flr die Proteinkinase (UL 97) und die DNA-Polymerase (UL 54)
von CMV determinieren die Ganciclovir-Resistenz, wahrend Resistenz gegen Foscavir aus-

schlieBlich durch Mutationen im Polymerase-Gen bedingt ist.

Empfindlichkeitstestung von HSV-1 gegeniiber Aciclovir

1. Infektion

Mikroskopische Kontrolle des Zell-Monolayers (humane embryonale Lungen-
fibroblasten) in den 96-well-Platten
Die folgenden Schritte werden unter einer Sicherheitswerkbank durchgefiihrt: Steril arbei-

ten! Handschuhe tragen!

Vorbereiten der Virusverdinnungen in Medium ohne Serum (MEM):
HSV-1-Patientenisolat: 10" bis 10

— Absaugen des Mediums
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— 1x Waschen mit 0,2 ml Medium ohne Serum (MEM)
— Infektion mit 0,2 ml/well der jeweiligen Virusverdiinnung
— 4 Parallelbestimmungen pro Verdinnung
Kontrollen nicht vergessen!
0 Zellkontrolle ohne Virus und ohne Substanz
0 Zellkontrolle ohne Virus mit der jeweiligen Substanzkonzentration (auf
Zytotoxizitat)
o Positivkontrolle mit Virus und ohne Substanz
— Adsorption: 1 h, 37°C, CO,-Inkubator (5 Vol % CO,)
— Absaugen des Inokulums (Kontaminationsgefahr!)
— Zugabe von 0,2 ml/well Overlay-Medium (MEM+2 % fotales Kélberserum), das folgende
Substanzkonzentrationen (uM) enthalt:
Aciclovir (ACV): 0,5; 1; 5; 10
Je Hemmestoffkonzentration eine 96-well-Platte anlegen
Viruskontrollen erhalten nur Medium ohne Substanz
Zellkontrollen erhalten entweder nur Medium oder Medium mit der jeweiligen Substanz-
konzentration.
— Inkubation: 48-72h; 37°C; CO,-Inkubator (5Vol %)

2. Auswertung

o Mikroskopische Auswertung des bereits fixierten* Zell-Monolayers im Lichtmikroskop

* Fixierung erfolgt durch Mitarbeiter des Instituts
— Medium absaugen
—  Fixieren mit 0,2 ml/well Ethanol/Aceton (95:5); 30 min; -20 °C

(In diesem Zustand kann die Platte bei —20 °C gelagert werden)

e Beurteilung, ob zytopathischer Effekt (CPE) in den verschiedenen Virusverdinnungen
und in Gegenwart der Hemmstoffe auftritt und Protokollierung auf beiliegendem Form-
blatt

e Berechnung des Virustiters fur jede Platte als die Verdinnung, bei welcher 50 % der
wells CPE zeigen ( 50 % tissue culture infectious dose; TCIDsy) auf beiliegendem
Formblatt

e Umrechnung TCIDs, /ml in plaque-forming-units (PFU)/mil:
PFU/ml = 0.7 x TCIDso /ml
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e Grafische Ermittlung der 50 % Hemmdosis (IDsy) flr Aciclovir gegen das HSV-1-

Patientenisolat

Anhang:

e Literatur
De Clercq E.:

Molecular targets for antiviral agents.

Journal of Pharmacology and Experimental Therapeutics (JPET)

297 (2001) 1-10

e IDsp-Werte gegeniiber HSV-1: <3uM sensitiv
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Roteln

Arbeitsgruppe Diagnostik — A. Stein

Die Rételn sind eine klassische Kinderkrankheit, doch 50 % der Infektionen im Kindesalter
bleiben asymptomatisch. Das Roételnvirus wird postnatal durch Tropfcheninfektion Gbertra-
gen. Es ist weltweit verbreitet; der Mensch ist der einzige Wirt. Zivilisatorische Einfliisse und
unvollstandige Durchimpfung der Bevélkerung flihren infolge Verzégerung der Durchseu-
chung zu sporadischen Infektionen bei Erwachsenen, mit entsprechender Wahrscheinlichkeit

der vertikalen Ubertragung in der Schwangerschaft.

Virus: Umhilltes RNA-Virus; Strukturproteine: Core-Protein C, Glykoproteine E1 und E2 der
Virushulle. E1 besitzt Hdmagglutinin-Funktion und ist deshalb einerseits fur die Infektion der

Wirtszellen, andererseits fiir die Diagnostik von grofder Bedeutung.

Symptome/Erkrankungen: Typisches kleinfleckiges Exanthem mit Kopfschmerzen, sub-
febrilen Temperaturen, Lymphknotenschwellungen, Katarrh der oberen Luftwege und Kon-
junktivitis. Eine Rotelnvirus-Primarinfektion im 1. Trimenon der Schwangerschaft fihrt mit

hoher Wahrscheinlichkeit zur Rételnembryopathie.

Siehe auch Merkblatt fiir Arzte vom Robert-Koch-Institut www.rki.de
http://www.rki.de/cln_151/nn_504470/DE/Content/Infekt/EpidBull/Merkblaetter/Ratgeber__Mbl__Roeteln.html

Hamagglutinationshemmtest (HHT)

(nach den Mutterschaftsrichtlinien vorgeschriebener Test fir das Screening der Schwangeren)

Testprinzip: Die Bestimmung basiert auf der Fahigkeit des Rotelnvirus, Erythrozyten zu

agglutinieren. Durch spezifische Antikorper in der Probe wird diese Agglutination gehemmit.
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Ablesen des Riteln-HHT

Prinzip
& Riteln- Riteln- Erythrozyt
Antikérper Virus
Keine Rételn-Antikdrper Riteln-Antikérper
im Serum vorhanden im Serum vorhanden
% Hiamagglutination % Hemmung der Himagglutination
Erys bilden einen ,, Teppich™ Erys sinken auf den Boden

OR®

Die letzte Serumverdiinnung mit
vollstindiger Hemmung #iihlt !
Titer = reziproke Verdiinnung

Diagnostische Bedeutung:

Ein Titer von 1:32 oder hoher gilt als Schutz vor einer Roételn-Infektion. Bei einem Titer <8

liegt keine Immunitat vor. Bei einem Titer von 8 oder 16 muss zur Klarung der Immunitats-

lage zusatzlich ein ELISA durchgefuhrt werden. Liegt kein Schutz vor, ist eine Roteln-

Schutzimpfung angezeigt (Kontraindikation: Schwangerschaft). Bei Verdacht auf eine frische

Infektion kann die Serumprobe mit Hilfe eines ELISA auf spezifische Rételn-lgM-Antikérper

untersucht werden.

Testdurchfilhrung:
Patientenseren:

1. Patientenserum |

2. Patientenserum Il

3. Patientenserum Il
Kontrollen:

1. negatives Kontroll-Serum

2
3.
4

positives Kontroll-Serum
Erythrozyten-Kontrolle (ohne Antigene und Serum)

Antigen-Kontrolle (ohne Serum)
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Pro Patienten- und Kontroll-Serum werden 8 Vertiefungen (z. B. Reihe A bis H), fir die Anti-

gen-Kontrolle werden 5 und fir die Erythrozyten-Kontrolle mindestens 2 Vertiefungen beno-

tigt.

Pipettierschema fur Roteln-HHT

1.

Ery-Kontrolle C

Ag-Kontrolle C

Neg.-Kontrolle C Ak

Pos.-Kontrolle C Ak

Pat-SerumIll C Ak

Pat-Serum!ll C Ak

Pat-Serum| C Ak

Ag

Ag

Ag

Ag

Ag

Ag

Verdunnung 1:

ER

ER

ER

ER

ER

ER

ER

8 16 32 64 128 256 512 1024

Je 25 yl CANM-L6sung (CaCl,, Rinderalbumin, NaCl, MgSQO,) in jede bendtigte Vertie-

fung pipettieren.

Verdunnung der Patienten- und Kontrollseren: Je 25 ul der vorbehandelten Patienten-

bzw. Kontroll-Seren in die 1. Vertiefung (A1-A5) der entsprechenden Reihe pipettieren.

Eine Verdiinnungsreihe bis zur 8. Vertiefung (A-H) durch Uberpipettieren von je 25 pl

herstellen. Aus der 8. Vertiefung werden 25 pl verworfen.

- Die Vorbehandlung wurde bereits durchgefihrt: Adsorption der Seren durch Kaolin-

behandlung und Warmeinaktivierung bei 56 °C, zur Ausschaltung thermolabiler und

thermostabiler Inhibitoren der Hamagglutination.

Far die Antigenkontrolle 25 pul des gebrauchsverdinnten Roteln-Antigens in die 1. Vertie-

fung der Antigen-Kontrolle pipettieren. Durch Uberpipettieren eine Verdinnungsreihe (A-

E) herstellen. Aus der 5. Vertiefung (E) werden 25 ul verworfen.
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4. Je 25 ul gebrauchsverdinntes Rételn-Antigen in jede Vertiefung der Patienten- und Kon-
troll-Seren pipettieren (A1/A5-H1/H5) (nicht in Antigen- und Erythrozytenkontrolle).

5. Platte gut schitteln und 1 Stunde bei Raumtemperatur (+ 18 bis 25 °C) stehen lassen.
Human-Erythrozyten-Suspension resuspendieren! Je 25 ul der gebrauchsverdinnten
Erythrozyten-Suspension in jede Vertiefung pipettieren.

7. Platte schitteln und bei Raumtemperatur erschitterungsfrei und vor direkter Sonnen-

strahlung geschitzt iber Nacht stehen lassen.

Bewertung:

e Die hochste Serumverdiinnungsstufe, bei der die vollstindige Hemmung der
Agglutination als scharf begrenzter Knopf vorliegt, gibt den Antikorper-Titer der
Patienten- und Kontroll-Seren an.

o Die Bewertung der Testansatze kann erst erfolgen, wenn die Erythrozyten-Kontrolle voll-
standig sedimentiert ist, d. h. der Erythrozytenknopf scharf begrenzt ist.

e Erst dann ist der Titer der Patienten- und Kontroll-Seren abzulesen. Der Titer ist durch
Vergleich mit der Erythrozyten-Kontrolle festzulegen.

e Die Bewertung der vollstindigen Hemmung der Agglutination kann durch das Schrag-
stellen der Platte erleichtert werden. Nur scharf begrenzte Knépfe bilden beim Schrag-
stellen der Platte eine ,Nase”. Vertiefungen, in denen die Agglutinationshemmung nicht
vollstandig ist, verandern ihr Bild durch das Schragstellen der Platte nicht oder deutlich
geringer als in den Vergleichskavitaten.

¢ Die Ablesung erfolgt gegen einen hellen Hintergrund.

e Die positiven Kontroll-Seren missen den angegebenen Titer + 1 Titerstufe erreichen.

¢ Das negative Kontroll-Serum muss in jeder Vertiefung eine Agglutination zeigen.

o Die HA-Aktivitdt der Antigen-Kontrolle wird ermittelt, indem die hoéchste Verdinnungs-
stufe, bei der noch eine deutliche Agglutination zu sehen ist, abgelesen wird.

e Das Antigen liegt in 4 bis 8 HA-Einheiten vor. Beim Vorliegen von 1 HA-Einheit kommt es
noch zur deutlichen Agglutination der Erythrozyten.

e In der Antigen-Kontrolle muss die Agglutination deshalb beim Vorliegen von 4 HA-Ein-
heiten in der 1. und 2. Vertiefung, beim Vorliegen von 8 HA-Einheiten in der 1., 2. und 3.

Vertiefung gefunden werden.
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Titer Bewertung

Negativkontrolle

Positivkontrolle

Patientin |

Patientin Il

Patientin Il

Frage:

Eine Frau in der frlhen Schwangerschaft hat vor kurzem Kontakt zu einem an Roételn
erkrankten Kind. Bewerten Sie anhand der ermittelten Daten fir die Patienten I-lll das

Ansteckungs- und Erkrankungsrisiko! Was ist zu tun?

Patientin I:

Patientin Il

Patientin Ill:
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Bitte bearbeiten Sie folgende Aufgaben zum Thema Rételn:

(98}
[\

64 128 256 5121024

Patientin D Tag 1

Patientin D Tag 10

Patientin E Tag 1

Patientin E Tag 14

ntin F

ntin G Tag 2

ntin G Tag 14

OO O OOO -
OO O @O -
OJOICXOXOIOIO
OJOICKOXOIOIO
OIOIOCROROIOIO)
000 © ©00®
000 © 00®
000 © 00®

Schematisch dargestellt sind die Ergebnisse des Roételn-Hamagglutinationshemmtestes

1. Lesen Sie die Roételn-Antikorpertiter ab

2. Beurteilen Sie die Situation, davon ausgehend, dass die Patientinnen schwanger sind (SSW
unbekannt) und Kontakt zu einem Kind mit Rételn hatten.

3. Welche zusatzliche Diagnostik wiirden Sie anfordern?

4. Welche zusatzlichen anamnestischen Fragen wirden Sie stellen?

5. Welche Malkhahmen wiirden Sie empfehlen?

Patientin D

Patientin E

Patientin F

Patientin G
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Liquordiagnostik

1. Allgemeines zum Liquor

Definition:

Lokalisation:

Funktion:

Volumen:

Produktion:

Ultrafiltration:

Resorption:

klare, farblose, eiweillarme, fast zellfreie Flissigkeit

inneres Liquorsystem (Ventrikel, Zentralkanal des Rulckenmarks) und

aulleres Liquorsystem (Subarachnoidalraum)

hydromechanischer Schutz, keine nutritive Funktion

100-200 ml beim Erwachsenen, bei Sauglingen 40-60 ml

durch Ultrafiltration in Plexus choroidei 70 % (350 pl/min)
durch Ultrafiltration von Blutplasma durch die Hirnkapillaren 18 %

plus Wasser, das bei Glucose-Verbrennung in Hirnzellen freigesetzt wird

Eintritt von Elektrolyten

aktiver, energieverbrauchender Transfer von Glucose
Albumin-Transfer (Pinozytose) Konzentrationsgefalle 1:200

in Abhangigkeit von der MoleklilgréRe schwerer IgG > IgA >>IgM
Konzentrationsgefalle IgG 1:400

von vendsen Abschnitten der Kapillaren in den weichen Hirnhduten

insbesondere in den sogenannten Pacchioni-Granulationen

2. Blut-Liquor-Schrankenstorung: Quotienten nach Prof. Reiber

Ursache:

Ziel:

Verminderter Liquorfluss durch a) verringerte Produktion, b) mechan.
Behinderung, c) verringerte Rickresorption
Flieligeschwindigkeit nimmt ab > mehr Proteine treten aus dem Blut Gber &

bei konstanter intrathekale Synthese steigt die Proteinkonzentration
Beurteilung der Entstehungsursache fir im Liquor nachgewiesene

Immunglobuline (u. a.)

Ig-Erhdéhung durch ,Schrankenstérung® oder intrathekale Synthese
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Beurteilung mit Hilfe des Reiberschemas (s.u.)

Abhangigkeit:

Verhaltnis von Albumin in Liquor und Blut (wird nicht im ZNS produziert)
Q Alb = Albuminyq / Albuminge,

Verhaltnis der Immunglobuline in Liquor und Blut
28.Q19G = 19Giq / 19Gser

Verhaltnis der Konzentrationsgradienten von Albumin und Immunglobulinen
ist nicht linear (Berechnung nach Link) sondern hyperbelférmig (nach Reiber)
Uber 4000 Patienten untersucht - empirische Hyperbel

jetzt auch theoretisch abgeleitet aus Diffusionsgesetzen

Limes: Hyperbole-beschreibende Formel zur Berechnung des oberen Grenzbereiches’
Qimigs = 0,93 4/(QAID)> +6*10°  -1,7*10°
Qimiga = 0,77 +/(QAIb)? +23#10°  -3,1*10°
Qimign = 0,67 1/(QAID)> +120%10° -7,1*10°
QlgG 100 Bu%ﬁu%‘twgu%
50
-3
=10
20
1ok Schema nach Reiber
5+
2
1 2 510 20 50100
w1072
QAIlb
1 Normal a 15 Jahre
2 reine Schrankenstérung b 40 Jahre
3 Schrankenstérung & intrathekale Ak-Synthese ¢ 60 Jahre

4 reine intrathekale Ak-Synthese

5 Nonsens
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3. Antikorperindex (Al)-Berechnung

Erreger-spezifische Quotienten:

Verhaltnis erregerspezifischer Antikoérper in Liquor und Serum

z. B. QHSV-IgG = HSV-IgGLiq / HSV-'gGser

Berechnung des erregerspezifischen Antikdrper-Index:

z.B. Al HSV|gG = QHSV-IgG / Q 19G bzw. Q lim 1gG (Kleineren Wert verwenden)
Normbereich 0,5-1,5; erhéht > 1,5; signifikant erhoht > 4

Beispiele:
Erkrankung Zellzahl Albumin lg-Klassen Verlauf
im Lig im Lig im Lig
Bakt. Meningitis hoch granulozytar | Hoch normal, (IgA) steigt in Stunden, fallt in
Tagen
Neuro-Borreliose Aktivierte B-Zellen | Hoch IgM, IgA, IgG Al Jahre erhoht,
(IgM) Schranke normal
in Frihphase
Neuro-Tbc Normal Hoch IgA, 1gG
Neuro-Syphilis Normal 1gG, IgM, Al Jahre erhoht
typ. kein IgA
GBS (Poly-radikulitis) Normal stark erhéht n. 2-3 normal Spinalwurzel-
Wo schwellungen
Chron. entziindl. Normal Normal IgG, IgM MRZ: Mas (60 %)
Prozess polyspezifische Rub (60 %)
(MS, Autoimmun, ZNS- Immunreaktion VZV (50 %)
Lupus, Optikus-Neuritis) HSV (25 %)
Auto-Ak (10 %)
Degener. Erkrkg. Normal Normal normal
(Alzheimer, CJK)
Virusinfektionen Gering eher normal kein IgA Al Monate bis Jahre

mononuklear

erhoht

konstante krankheitstypische Muster, immunologisch ,untypischer” Verlauf

andere neuroimmunologische Regulation (nicht IgM, IgA = IgG) = erhdhter Al spricht nicht

immer fur akute Infektion, sondern

a) akute Erkrankung (aufder bei erhdhtem IgA-Al bei bakteriellen Erkrankungen)

b) postakute Phase ohne klinische Relevanz

c) Teilreaktion einer polyspezifischen Immunantwort bei akuten der chronisch entziindlichen

Prozessen (MS, Autoimmunerkrankungen mit ZNS-Beteiligung)

Seminarprasentation:

Besonderheiten:
HSV-Enzephalitis:

VZV-Meningitis:

Al-Berechnung aus der Praxis (Ai_ligti.xlw Arbeitsblatt Liquorwerte)

HSV 4cAl erst 7-10 Tage nach Klinikbeginn erhoht (Max d 25)
kann Uber Monate und Jahre persistieren
HSV guAl <560%, HSV gaAl <20% erhdht in spater Phase

VZV 4cAl schon 1-6 Tage nach Klinikbeginn erhoht (Max d 12)
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VZV gvAl selten, VZV Al fast nie erhoht
VZV-Ganglionitis: VZV 4cAl noch 2 Jahre nach Rekonvaleszenz erhéht (1 Fall)
wichtigstes Kriterium zur DD bei Fazialisparese (VZV, Borreliose)
HIV-Enzephalitis in Abhangigkeit vom Stadium HIV-Al erhdht 1-47% 11-67% 111-84%
in Phase Il bei 20% ohne Klinik HSV|4cAl erhdht

Bitte bearbeiten Sie folgende Aufgaben zum Thema Liquordiagnostik:

Masern-Antikdrperindex

Patient mit unklarer neurologischer Symptomatik 64 Jahre, mannlich
Werte aus dem Liquorlabor:

Albumin Liquor 228 mg/I

Albumin Serum 45,5 g/l

IgG Liquor 93,4 mg/l

IgG Serum 8,1 g/l

Q gesamt IgG=
QlimIgG = 3,3x10°

Masern-lgG Liquor= 1,1 AU (arbitrary units)
Masern-lgG Serum= 89,6 AU
Qspez=
Masern-Al =
Wie interpretieren Sie diesen Befund?
a)
b)
Welche weiterfihrenden Untersuchungen empfehlen Sie, um die Diagnose zu untermauern?

Zu a)

zu b)
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Quantitativer Nachweis von Epstein-Barr-Virus-DNA mittels
real-time PCR am LightCycler

Arbeitsgruppe Diagnostik — J. Ettinger, S. Kersten

1. Theoretische Einfiihrung
1.1 Epstein-Barr-Virus (EBV)

humanpathogenes behilltes, doppelstrangiges DNA-Virus aus der Familie der
Herpesviridae

Hauptibertragungsweg: Tropfcheninfektion oder Kontaktinfektion (besonders
Speichel) bzw. Schmierinfektion

Infektionen im Kindesalter - meist keine Symptome; jugendliche oder erwachsene
Infizierten zu 30-60% mit infektidser Mononukleose (Pfeiffersches Driusenfieber mit
hohem Fieber, Lymphknotenschwellungen); ab 40. Lebensjahr ca. 98% infiziert

Virus persistiert in B-Lymphozyten lebenslang, kann wie alle Herpesviren bei
Immunsuppression reaktivieren (z.B. nach Knochenmarkstransplantation, KMTx)

Virus kann zur Entstehung von verschiedenen seltenen Krebserkrankungen flihren

1.2 EBV-Diagnostik
- ELISA: Viruscapsid-Struktur-Antigen (VCA)-IgG, -IgM; EBNA-1-IgG
- Immunoblot: weitere Ak-Differenzierung und Aviditatsbestimmung bei unklarer

- PCR:

Konstellation
EBV-DNA-Direktnachweis
quantitativ => aus EDTA-Blut zur Bestimmung der Viruslast flir zuverlassige Ein-
schatzung von EBV-Reaktivierung bei Immunschwache (bei Immun-
gesunden meist nicht sinnvoll, da im Blut auch das latente Genom
nachweisbar ist); bei EBV-assoziiertem Lymphom nach Organtrans-
plantation

qualitativ => ggf. aus Liquor bei Verdacht auf Meningoenzephalitis

1.3. Quantitativer Nachweis von EBV-DNA
1) Isolierung der EBV-DNA aus der Probe

2) Real-time PCR (Echtzeit-Polymerasekettenreaktion)

Amplifikation eines 74-bp-groften Abschnitts des flir das nicht-glykosylierte Membran-
protein BNRF1 p143 von EBV kodierenden Gens

Detektion des entstehenden PCR-Produkts durch Messung eines nach dem TagMan-
Prinzip generierten Fluoreszenzsignals in der Elongation
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3) Computer-gestiitzte Analyse des Reaktionsverlaufs mit Bestimmung des Cp-Wertes
(crossing point)

4) Quantifizierung von EBV-DNA anhand einer Eichgeraden

1.4. Prinzip der real-time PCR unter Verwendung des TagMan-Prinzips
1.4.1 PCR
- molekularbiologische Methode, mit der gezielt DNA-Abschnitte vermehrt werden kénnen

- Amplifikation bendtigt:

o zwei einzelstrangige Oligonukleotide (Primer), die komplementar an der Ziel-
DNA binden und Gréfte des PCR-Produkts (Amplifikat) bestimmen

. thermostabile DNA-abhangige DNA-Polymerase

o Desoxynukleosid-Triphosphaten (dATP, dCTP, dGTP, dTTP)

- Amplifikationszyklus besteht allgemein aus:
1. Denaturierung (Aufschmelzen doppelstrangiger DNA; 95°C)
2. Annealing (Binden der Primer; etwa 55 - 60°C)
3. Elongation (Verlangern der Primer; 72°C)

1.4.2 TaqMan-Prinzip

Taq
OO OO O T

OO -

- Neben Primern hybridisiert TagMan-Sonde (= markiertes Oligonukleotid) spezifisch an
Ziel-DNA (= Target)

- Sonde ist am 5-Ende mit einem Fluoreszenzfarbstoff als Reporter (R) und am 3’-Ende
mit einer die Fluoreszenz I6schenden Komponente, dem Quencher (Q) markiert

- trifft die Tag-Polymerase bei der Amplifikation auf die doppelstrangige DNA aus Target
und Sonde bedingt ihre 5’-Nukleaseaktivitat den hydrolytischen Abbau der Sonde

- Reporter wird freigesetzt; dessen raumliche Trennung vom Quencher ist mit der

Entstehung eines definierten Fluoreszenzsignals verbunden
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2. Gerate und Hilfsmittel
fur DNA-Praparation:

fir real-time PCR:

Allgemein:

3. Reagenzien

fur DNA-Praparation:

fur real-time PCR:

4. Durchfiihrung

Vortex Mixer
Heizblock
Tischzentrifuge

LightCycler Instrument 2.0 (Roche)
Zentrifuge fur LightCycler-Karussell
Glaskapillaren mit Deckel

Eppendorfpipetten
Pipettenspitzen mit Filter
Reaktionsgefalle (Eppendorfbecher)

QlAamp DNA Mini Kit (QIAGEN)
Ethanol (96%) (Merck)

LightCycler® FastStart DNA Master™ S HybProbe (Roche)
Uracil-DNA-Glycosylase (UNG), hitzelabil, 1U/ul (Roche)
Nuklease-Free Water (Promega)

fetales Kéalberserum (FKS), Seromed

Primer-Sonden-Gemisch mit
EBV-Primer 1 und 2 (je 2,5 mM)
EBV-spezifische Sonde, FAM/TAMRA-markiert (0,75 uM)
Sonde fur Interne Kontrolle, DYXL/BHQ2-markiert (0,75 uM)

Interne Kontrolle (IC; Plasmid pEBV-IC, 250.000 cp/ml)
Zellkulturiiberstand (ZKU, 2x 10° cp/ml)
Positivkontrolle (PK; Plasmid pEBV-Standard, 3.000 cp/ml)

Alle Arbeiten werden mit Handschuhen ausgefihrt!

4.1 Herstellen von Verdiinnungen des Zellkulturiiberstandes

. ) Verdunnungs- fetales o
Nr. ZKU-Verdinnung ) Virustiter
faktor Kélberserum

(1) - - - 200.000 cp/ml
(2) 100 pl (Nr. 1) 1:4 300 pl 50.000 cp/ml
(3) 60 pl (Nr. 1) 1:10 540 pl 20.000 cp/ml
4) 60 pl (Nr. 2) 1:40 540 pl 5.000 cp/ml
(5) 60 pl (Nr. 3) 1:100 540 pl 2.000 cp/ml
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4.2 Isolierung der EBV-DNA (je n=1)
1) Verdiinnungen des Zellkulturiberstandes (1) — (5) (siehe 4.1)

a. aus FKS => Negativkontrolle

Isolierung erfolgt nach dem Manual aus dem QlAamp DNA Mini Kit (siehe Kurzprotokoll)
4.2.1 Kurzprotokoll zur Isolierung von Virus-DNA mit dem QlAamp DNA Mini Kit

20ul Proteinase K
+ 200ul Probe
+ 200pl Lysepuffer AL

Vortexen 15 min 56°C (Heizblock)

A4
+ 25pl PolyA / IC-Mix (15ul PolyA + 10ul IC-Mix)
+ 200pl Ethanol

Vortexen kurz anzentrifugieren
A 4

Auf die Qiamp Saule pipettieren

1 min 8.000 U/min zentrifugieren

+ 500ul AWA

1 min 8.000 U/min l zentrifugieren

+ 500p1 AW2

3 min 14.000 U/min l zentrifugieren

+ 100pl Puffer AE
1 min bei Raumtemperatur stehen lassen

1 min 8.000 U/min zentrifugieren
A 4

QlAamp-Saule verwerfen und Eluat (DNA) in die PCR
einsetzen

4.3. Herstellen des Mastermixes fiir die real-time PCR

Reaktionsbestandteile 15 Reaktionen
Nuklease-Free Water 115 pl
Polymerase-Mix 1 aus dem LightCycler® 60 pl
FastStart DNA Master™ S HybProbe Kit
UNG 5 pl
Primer-Sonden-Mix 60 ul
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4.4 Beladen der Kapillaren

je Reaktionsansatz werden pipettieren: 15 yl Mastermix

+ 5 pl DNA-haltiges Eluat

Ansatz DNA Ansatz DNA
1 ZKU (1) 7 ZKU (4)
2 ZKU (1) 8 ZKU (4)
3 ZKU (2) 9 ZKU (5)
4 ZKU (2) 10 ZKU (5)
5 ZKU (3) 11 NK
6 ZKU (3) 12 Std. (2x 10°)
13 PK

4.5 Starten des LightCyclers

Gerat einschalten

Rechner, Bildschirm, LightCycler und Drucker
einschalten

LightCycler software 4 mit Doppelklick 6ffnen

Eingabe: Name: User01

Passwort:: User01

Login

in Menduleiste => View => Front anklicken

in LightCycler Software Vers. 4.0 New Experiment
anklicken

Gerate-Selbsttest

in Menuleiste => Options
Run self Test anklicken

Laden der
Reaktionsanséatze

Kapillaren mit PCR-Reaktionsansatzen in Probenkarussell
setzen

in blauem Rotor-Bucket fur 15s bei 2.000 U/min in LC-
Zentrifuge zentrifugieren

10 min bei Raumtemperatur stehen lassen

Probenkarussell mit Kapillaren in LightCycler setzen, Deckel
schlielen lassen

Auswahl des PCR-
Programmes

in Menlleiste => Template

Run Templates => Open anklicken

Standard PCR Run Protocol markieren:
Tag-Aktivierung: 95°C 10 min

55 Zyklen: 95°C 55
60°C 30s
Abkuhlen 40°C 30s

Open anklicken
in Setup unter Max. Seek Pos die Anzahl der Kapillaren
eingeben sowie Kapillargrofle (20 pl)
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Start des PCR-
Laufs

in Menuleiste => Run => Start Run anklicken

Name in Save LC Experiments eingeben:
JIJI-MM-TT Virus® (z.B. ,.2007-02-27 EBV*)

=> Save

Probenbezeichnung

in Mendleiste => Samples anklicken

in Sample Data Bezeichnung der Proben und Kontrollen eingeben
fur Quantifizierungen unter Sample Typ Reaktionsansatz
spezifizieren (,Unknown* fir Probe; ,Standard")

bekannte Standard-Konzentration eingeben

Auswertung

qualitativ Proben
(FAM)

Interne Kontrollen
(DYXL)

quantitative

in Menuleiste => Analysis => Create New Analysis zwischen
Qualitative Detection und Absolute Quantification wahlen
Channel 530 nm anklicken

Punktierte Linie nach rechts ziehen bis Ergebnisse sichtbar
werden

Advanced anklicken => Cp-Werte angezeigt

in Mendlleiste => File => Print Window => OK

Channel 705 nm anklicken

in Mendlleiste => File => Print Window => OK

zur Generierung einer Eichgeraden in Absolute Quantification
Standards markieren

in Menuleiste => Standard curve anklicken => Save as

fur Nutzung von externer Eichgerade: auswahlen unter Standard
curve => Eichgerade auswahlen => Use external in Select Object
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HIV-Diagnostik

Arbeitsgruppe Diagnostik — J. Ettinger

1. Theoretische Grundlagen:

Besprochen wird das diagnostische Vorgehen zur Feststellung einer HIV Infektion sowie

deren Therapie (s. auch die schematische Darstellung der Westernblottechnik)

Diagnostik:
e Serologie
0 Antikorper-/p24Antigen-Nachweis im ELISA = sensitiver Suchtest (A1)
0 Antikérpernachweis im Westernblot bzw. Immunoblot = spezifischer
Bestatigungstest (A2)
0 Schnelltest zum Antikérpernachweis (A3)
e Molekularbiologie
0 quantitative HIV-RNA-Bestimmung im Serum zum Therapiemonitoring
o qualitativer HIV-RNA-Nachweis bei besonderer Indikation (Organ- und
Blutspendewesen, = Neugeborene von  HIV-positiven  Mdttern,
postexpositionelle Frihdiagnostik)
e andere Untersuchungen

0 CD4 Zellen quantitativ als immunologischer Marker

Therapie der HIV-Infektion: Reverse Transkriptase-Hemmer (Nukleosidale und Nicht-
Nukleosidale RT-Hemmer), Protease-Hemmer, Integrasehemmer, Fusionshemmer, CCR5-
Antagonisten; in aller Regel als Kombinationstherapie (HAART = highly active antiretroviral

therapy).

2. Genotypische HIV-Resistenztestung mit Demonstration zum Alignment und

zur Auswertung von HIV Sequenzen

In dem Praktikum soll der Stellenwert der HIV Resistenztestung fiir die Klinik sowie Vor- und
Nachteile der einzelnen Methoden diskutiert werden. An einigen Kasuistiken soll das prakti-
sche Vorgehen bei der Bewertung genotypischer Daten demonstriert (Alignment von
Sequenzierungsdaten, Auswertung von Sequenzdaten Uber das Internet mit verschieden

Auswertungsalgorithmen), sowie die Wertigkeit von Mutationen diskutiert werden.
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HIV-Resistenztestung

Theoretische Grundlagen: Verfahren der HIV Resistenztestung

Die Grundlage fir resistente HIV-Viren sind veranderte Eigenschaften der Reversen
Transkriptase und Protease. Deshalb werden die Abschnitte, die fir diese beiden Enzyme

kodieren, aus der viralen RNA isoliert und auf Veranderungen untersucht.

Fur die Analyse der entsprechenden RNA-Abschnitte stehen mit der Genotypisierung und
Phanotypisierung zwei unterschiedliche Verfahren zur Verfugung. Damit beide Verfahren
sicher durchgefiihrt werden kénnen, sollte die Viruslast mindestens 1000 Kopien/ml Plasma

betragen.

Der Anteil einer Virusvariante an der Gesamtpopulation muss ca. 25 % betragen, damit
diese nachgewiesen werden kann. D. h. eine nicht nachgewiesene Resistenz bedeutet nicht
zwangslaufig, dass diese in der Viruspopulation nicht vorhanden ist. So kdnnen frihe
Resistenzentwicklungen eventuell unerkannt bleiben, die spater eine klinische Bedeutung

erlangen.

¢ Genotypisierung

Bei der Genotypisierung wird die genetische Information der Reversen Transkriptase und
Protease des Patientenvirus mit der entsprechenden Information des Wildtyp-Virus vergli-
chen. Aufgrund der hohen Variabilitat haben nicht alle Unterschiede zum Wildtyp-Virus auch
Einfluss auf die Resistenz gegen Medikamente. Die entdeckten Mutationen missen daher
hinsichtlich lhrer resistenzvermittelnden Eigenschaften interpretiert werden. Daflir sind Aus-
wertungsschemata, auch Auswertungsalgorithmen genannt, notwendig.

Vorteil der Genotypisierung ist die schnelle, relativ unkomplizierte und damit vergleichsweise

glnstige Durchfiihrung der Resistenzbestimmung.

e Phanotypisierung
Bei der Phanotypisierung wird die Replikationsfahigkeit eines HIV-Patientenisolats im Ver-
gleich zum HIV-Wildtyp in Anwesenheit von Medikamenten direkt untersucht. Es handelt sich

dabei — verglichen mit der Genotypisierung — um ein aufwandigeres Verfahren. Es dauert ca.

4 — 6 Wochen, bis der Befund vorliegt und auch die Kosten sind héher.
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3. Praktikum

In dem Praktikum soll der Stellenwert der Resistenztestung fiir die Klinik sowie Vor- und
Nachteile der einzelnen Methoden diskutiert werden. An einigen Kasuistiken soll das prakti-
sche Vorgehen bei der Bewertung genotypischer Daten demonstriert (Alignment von
Sequenzierungsdaten, Auswertung von Sequenzdaten Uber das Internet mit verschieden
Auswertungsalgorithmen), sowie Wertigkeit von Mutationen und die nicht unerheblichen

Kosten diskutiert werden.

A1 - Prinzip des HIV-Suchtests

Enzymmarkierter anti-
human Antikérper

Serumantikorper ; k : §

Antigen <> <«— Antigen aus Serum

(\:izomt\)/ﬁrot% <4— antip24
und HIV-2) ﬁ
1 2 3 4

An die feste Phase (Platte) gebundenes Antigen wird mit Serum des Patienten bzw.

—_—

negativen oder positiven Kontrollseren tberschichtet

2. Bindung der HIV-Antikérper an das HIV-Antigen, Auswaschen der nicht-gebundenen
Antikorper

3.  Zugabe eines zweiten Enzym-markierten anti-human-Antikorpers (tierischer Antikorper
gegen humane Antikorper)

4, Bindung des markierten anti-human-Antikérpers an den Antigen-Antikdrperkomplex,
Auswaschen der nicht-gebundenen Antikérper

5.  Zugabe von Chromogen, Auslésung der Enzymreaktion und Messung der optischen
Dichte (Farbung) als Maly fir die Menge an HIV-spezifischen Antikérpern im
Patientenserum

6. Die neue Testgeneration verwendet an die feste Phase gebundene p24 Antikorper,
die mit Antigen des Patienten interagieren und Uber einen 2. Antikbrper mit

Chromogen nachgewiesen werden.
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A2 - Prinzip des HIV-Bestatigungstests

Gelelektrophorese o Transfer der Proteine 9 Testkit 9

auf Nitrozellulose Herstellung der Blotstreifen
@ 1.) Elektrophoretische
] Trennung von lysiertem HIV
M Bpriehe im SDS-Polyacrylamidgel.

2.) Elektrotransfer der
Proteinbanden auf

Nitrozellulose mit
i an_schllefSender Blockierung
Diagnostic Compeny AG freier Stellen durch

Inertprotein, und Zertrennung
der Nitrozellulose in Streifen
(Blotstreifen).

@ = 3.) Verpackung in einen
(—l) |:> (-l-) kommerziellen Testkit.

Auftrennung nach MW

9 Patentenserun o 6 Testdurchfiihrung im Labor
'{ 6 4.) Vorbereitung der
fﬁf ‘]\ f( Enzym Enzym Blotstreifen.

mit den zu untersuchenden
Patientenseren.
l 1 l 1 6.) Waschen der Blotstreifen
zum Entfernen der
nichtgebundenen Antikorper.
@ 7.) Inkubation der Blotstreifen
mit Enzym-markierten
Antikorpern (gerichtet gegen
A b5 humanes IgG) und
anschlieRender

NN A A A Substratreaktion.

Teststreifen [ | - . . . 8) Befundung

/( nzym 5.) Inkubation der Blotstreifen
HIV Western-Blot }\ A ’f'\—- A ﬁ

Diagnostic Company AG

T A HiV-spezifischer AK

A3 - Prinzip des HIV-Schnelltests

Der HIV Schnelltest ist ein optisch ablesbarer, qualitativer Immunoassay fur den Nachweis

von HIV-1 und HIV-2 Antikdrpern in Serum und Plasma.

Die Probe wird auf das Probenfeld gegeben. Die Probe wandert durch das Konjugatfeld, 16st
dabei das Selenkolloid-Antigen-Konjugat und vermischt sich mit diesem. Diese Mischung
lauft weiter durch die Festphase bis zu der Stelle das Patientenfensters, an der die rekombi-

nanten HIV-Antigene und synthetischen Peptide immobilisiert vorliegen.

Falls sich Antikorper gegen HIV-1 und HIV-2 in der Probe befinden, binden sie an das Anti-

gen-Selenkolloid und an das Antigen im Patientenfenster und erzeugen eine rote Linie.
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Sind keine Antikdrper gegen HIV-1 und/oder HIV-2 vorhanden, fliel3t das Selenkolloid-Anti-
gen-Konjugat am Patientenfenster vorbei, und es entsteht keine rote Linie im Patienten-

fenster.

Um die Gultigkeit des Tests sicherzustellen, enthalt der Assay eine als solche gekennzeich-
nete Verfahrenskontrolle (Kontrollinie am oberen Rand des Tests). Farbt sich die Kontrollinie
nach Beendigung des Assays nicht rot, ist das Testergebnis unglltig, und die Probe sollte

erneut getestet werden.

Immunochromatographischer Schnelltest zum

Nachweis von HIV-1/2/0 Antikérpern Prinzip
Selenkolloid- immobilisierte immobilisierte HIV-
Antigen- rekomb. Antigene spezif. ‘f\““kﬁmr‘
Konjugat und synth. Peptide und markiertes Peptid
Serum- Konjugatfeld Patienten- Kontroll-
Pipettierfeld fenster fenster
—»
T | | - "

Serum- Konjugatfeld Patienten- ~ Kontroll- |
Pipettierfeld fenster fenster

Interpretation der Ergebnisse:

Positiv (Zwei Linien)

Eine rote Linie erscheint sowohl im Kontollfenster (,Kontrollinie®) als auch im Patientenfens-
ter (,Patientenlinie“) des Teststreifens. Jegliche sichtbare rote Farbe im Patientenfenster

sollte als positiv gewertet werden.

Kontrollinie

Patientenlinie

Negativ (Eine Linie)
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Eine rote Linie erscheint im Kontrollfenster (,Kontrollinie®) des Teststreifens. Im Patienten-

fenster (,Patientenlinie”) des Teststreifens erscheint keine rote Linie.

Kontrollinie

Patientenlinie

Ungultig (Keine Linie)
Erscheint im Kontrollfenster des Teststreifens keine rote Linie, ist das Ergebnis ungdltig,

selbst wenn im Patientenfenster des Teststreifens eine rote Linie erscheint, und der Test

sollte wiederholt werden.

Kontrollinie Kontrollinie

Patientenlinie

Patientenlinie
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Aktivierung des intrinsischen Interferonsystems

Arbeitsgruppe Rang

1. Einleitung

Interferon-System

Ein Virus 16st in infizierten Zellen generell Alarmsignale aus, die u.a. zur Produktion von Typ
| Interferon alpha/beta (IFNo/p)) und Type Il IFN-lambda (IFNA)) fuhren. Diese IFN-
Stimulation kann ubiquitar in nahezu allen Zellen ausgelost werden. Innerhalb der letzten
Jahre sind viele Modelle entwickelt worden, um die Aktivierung dieses intrinsischen IFN-
Systems erklaren zu kdnnen. Im Fokus stehen sogenannte pattern recognition receptors
(PRR) einschlieBlich RIG-dhnlichen RNA-Helikasen und toll like receptors (TLR), die
konservierte Pathogen-assoziierte molekulare Strukturen (pathogen associated molecular
patterns, PAMP) von Bakterien und Viren erkennen konnen. Die spezifische Interaktion
zwischen PRR and PAMP I6st die IFN-Synthese und andere angeborene Immunreaktionen

aus.
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Induktionsphase Effektorphase

Modell zur Aktivierung intrinsischer Immunreaktionen durch eine Virusinfektion. In der
Induktionsphase kommt es Uber die Interaktion zwischen viraler RNA und zellularen
Erkennungsrezeptoren (PRR) zur Expression von IFNB und IFNA. In der anschliellenden
Effektorphase induzieren diese |IFNe Uber die Aktivierung des JAK/STAT
Signaltransduktionswegs die Expression IFN-induzierbarer Gene (ISG). Mit der ISG-
Expression etabliert sich ein antiviraler Status, der die Zelle vor einer Virusinfektion schutzt.
Abbildung aus Haller, Kochs und Weber 2005 Virology 79: 2079.
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Die Aktivierung des IFN-Systems erfolgt Uber die Bildung von Typ | IFNo/f und Typ Il IFNA.
Diese Zytokine losen Uber IFN-Typ-spezifische Oberflachenrezeptoren intrazellulare
Signalkaskaden aus, die mit der Aktivierung des Transkriptionskomplexes IFN stimulated
gene factor 3 (ISGF3) verbunden sind. Aktiviertes ISGF3 gelangt in den Kern und bindet
sogenannte IFN stimulated response elements (ISRE) in den Promoterbereichen IFN-
induzierbarer Gene, wodurch deren Expression stimuliert wird. Durch IFN kénnen mehr als
1000 unterschiedliche Gene induziert und Zellen in einen antiviralen Status versetzt
werden. Die in diesen Status versetzten Zellen in der Umgebung des primaren

Infektionsherds dienen als Schutzwall, um eine Ausbreitung des Virus im Wirt zu verhindern.

Eine verminderte Virulenz vieler Viren ist verknlpft mit einer starken Induktion von IFN. Dies
scheint auch flir Hantaviren zu gelten. In vitro wird IFN durch das nicht pathogene Prospect
Hill Hantavirus starker und schneller aktiviert, als durch das pathogene Hantaanvirus. Die
grundlegenden Mechanismen fir diese differenzielle Aktivierung des intrinsischen IFN-
Systems sind nur ansatzweise bekannt (Handke et al. 2009 J. Immunol. 182:2849; Handke
et al. 2010 J. Gen. Virol. 91:2351; Rang 2010 Critical Reviews in Immunology 30:515).

2. Funktionelle Untersuchung der intrinsischen IFN-Antwort

Im Praktikum sollen grundlegende Techniken durchgefihrt werden, mit deren Hilfe
Wirkmechanismen des angeborenen IFN-Systems charakterisiert werden kénnen. Das IFN-
System unterschiedlicher Zelllinien soll durch transiente Transfektion von Plasmid DNA
stimuliert werden. Die Transfektion simuliert eine Virusinfektion und dient als Surrogatsystem

fur die detaillierte funktionelle Untersuchung.

2.1. Stimulation unterschiedlicher Zelllinien und funktionelle PRR
Untersuchung

Es werden die humanen Nierenepithelzelllinie HEK293T und die Hepatomzelllinien HuH7
und HuH7.5 verwendet. Die HuH7.5 Zelllinie ist funktionell RIG-I defizient aufgrund einer
Mutation im RIG-I Gen. Die verwendeten Zellen wachsen adherent und werden in 12er
Platten so ausgesat, dass sie am folgenden Tag subkonfluent sind. Stimuliert werden die
Zellen entweder mit rekombinantem IFNalpha (1.000 IU/ml) oder durch die Transfektion von
Plasmid DNA mit Lipofektamine 2000 (siehe Tabelle 1 und 3). In einem zweiten Ansatz
werden unterschiedliche Expressionsvektoren fiir verschiedene PRRs transfiziert, um den
Effekt der PRR-Expression auf die Aktivierung des IFN-Systems zu testen (siehe Tabelle 2
und 4).
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Tabelle 1) Stimulation unterschiedlicher Zelllinien

Probe | Zell-Linie Stimulus Ergebnis

%GFP pos IFN-
Antwort

HuH7 Ohne

IFNalpha 1.000

pGFP

HuH7.5 Ohne

IFNalpha 1.000

pGFP

HEK293T Ohne

IFNalpha 1.000

OO NN WIN|—

pGFP

Tabelle 2) PRR Uberexpression in HEK293T Zellen

Probe | Zell-Linie Stimulus Ergebnis

IFN-Antwort

HEK293T Ohne

IFNalpha 1.000

PRIG-I

TLR3

AW IN|=

TLR9

Transfektionsprotokoll:

Plasmid DNA (0,5ug) in 50ul OPTI-MEM Medium geben

1,5 pl Lipofectamine 2000 in 50ul OPTI-MEM Medium mischen und fir 5 Min. bei
Raumtemperatur (RT) inkubieren

DNA und Lipofektamine Ansatze vereinen, kurz vermischen und 20 Min. bei RT
inkubieren

Transfektionsansatz méglichst gleichmagig auf die Zellen einer Kavitat der 12er

Platte tropfen.

Tabelle 3) Pipetierschema fiir die GFP Transfektion (100ul Endvolumen pro Ansatz)

Ansatze Optimem

GFP pGFP (___ pg/ul) 4 (4 x 0,5ug) | (4 x50ul)
V] 200pl

Lipofectamine 4 (4 x 1,5ul) | (4 x50ul)
6 pl 200pl
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Tabelle 4) Pipetierschema der PRR Transfektion (100l Endvolumen pro Ansatz)

Ansatze Optimem

GFP pGFP (___ pg/ul) 2 (2x 0,5ug) | (2 x50ul)
Ml 100ul

Lipofectamine 2 (2x 1,5pl) | (2x50pl)
3ul 100pl

RIG-I pRIG (___ pg/ul) 2 (2x 0,5ug) | (2 x50ul)
pl 100pl

Lipofectamine 2 (2x 1,5ul) | (2 x50ul)
3ul 100ul

TLR3 pTLR3 (___ pg/ul) 2 (2x 0,5ug) | (2x50ul)
Ml 100ul

Lipofectamine 2 (2x 1,5ul) | (2x50pl)
3ul 100pl

TLR9 pTLRO (___ pg/ul) 2 (2x 0,5ug) | (2 x50ul)
pl 100pl

Lipofectamine 2 (2x 1,5ul) | (2 x50ul)
3ul 100pl

2.2. RNA Ernte 24 Std. nach der Transfektion

Bemerkungen: Trifast Reagenz enthalt Phenol Guanidiniumthiocyanat

Extrakte enthalten wasserlosliche alkoholunldsliche Materialien, die UV - Adsorbtion ahnlich

wie Nukleinsauren haben =» OD - Konzentrationsbestimmung nicht zuverlassig!

- Zellen mit PBS waschen und in 400yl Trifast -Reagenz lysieren

- Lysat mehrmals mit der Pipette auf- und abpipettieren und in 2ml Tube Uberflihren

- Probe 5 Min. bei RT inkubieren

- Zugabe von 100pul Chloroform (ohne Zusatze) zugeben und 157" kraftig mixen

- Probe 5 Min. bei RT inkubieren

- Homogenat 15 Min. mit 12.000 x g (11.500 upm Eppendorf) zentrifugieren

- farblose Oberphase (enthdlt RNA) in neues Tube Uberfiihren
- RNAin 0,67 x Vol Isopropanol bei -80°C 30 Min fallen

- 15 Min max speed zentrifugieren

- Pellet 1 xin 400 pl 70% EtOH waschen, trocknen und in 50ul Wasser resuspendieren

- 5pl der RNA Probe in 95ul Wasser verdiinnen und OD bestimmen.

2.3. Reverse Transkription der RNA-Proben
Von den RNA Proben werden jeweils 6ul in neues Tube Uberfiihrt und mit der Moloney
Murine Leukemia Virus (M-MLV) Reversen Transcriptase (RT) in cDNA ungeschrieben. Als

Starter werden random Hexamer Primer verwendet.
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Pipetierschema fiir die RT-Reaktion

MASTER-MIX Ax 15x
First strand buffer (5x) 3 ul 45,0 ul
dNTP’s (je 10mM) 1,5 ul 22,5 pl
DTT (0,1M) 1,5 pl 22,5 yl
Random Primer Fermentas [200ng/pl]
- Verdlinnung 1:8 (25ng/ul) 2 ul 30,0 ul
RNase Inhibitor (ca. 0,5pro Ansatz) z.B. 0,5 pl 7,5
M-MLV RT Invitrogen (200U/pl) 0,5 pl 7,5 pl
Endvolumen 9 ul Je 9 ul plus 6pl
Endvolumen plus RNA 15 pl RNA mixen

e vortexen und kurz zentrifugieren
e 90 Min bei 37°C
e 15 Min bei 70°C

2.4. Quantitative Bestimmung vom IFN-lambda mRNA mittels Light Cycler PCR

Die Menge der IFN-lambda mRNA in den hergestellten cDNA Proben wird im Light Cycler
1.0 (Roche) mit Hilfe des SYBR Green PCR Kits (Invitrogen) bestimmt.

Primer Paar PP 1) IFN-lambda (222BP)

Primer Paar PP 2) GAPDH (595 BP)

Cycler — Programm

Initial activation step 2 min95°C

Cycling 50 x:

Denaturation 15s 95°C

Annealing 30s 60°C

Extension 40s 72°C

Acquisition 88°C

Mastermix GAPDH

Wasser 15 x 0,2 yl Wasser 1,2 ul

BSA (1 mg/ml) 15 x 5,0 ul BSA 30 pl

Primer f (10mM) 15 x 1,4 pl Primer f 8,4 ul

Primer r (10mM) 15 x 1,4 pl Primer r 8,4 i

MM CYBRGreen 15 x 10,0 pl MM 60,0 pl
Endvol: | 18,0 pl
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Ergebnis der QPCR

Proben Template Ct-Wert Ct-Wert
aus cDNA GAPDH IFN-lambda

HuH7

HuH7 IFN

HuH7 pGFP

HuH7.5

HuH7.5 IFN

HuH7.5 pGFP

HEK

HEK IFN

HEK pGFP

HEK

HEK IFN

HEK pRIG-I

HEK pTLR3

HEK pTLR9

o|o|h|w|N|=|o|o|No|o|sw|d = £

Wasser

Zeitliche Planung

Gruppe 1
Do 14:30 — 18:00 - theoretische Einfuhrung in der Bibliothek
- RNA Isolation der Zellen, die von Gruppe 2 am Vortag stimuliert
wurden
Fr 17:00 — 18:00 - Reverse Transkription der isolierten RNA
Di 14:30 —18:00 - quantitative PCR
- Transfektion von 293, HuH7 und HuH7.5 Zellen
Do 15:30 - 17:30 - Immunfluoreszenz-Analyse der transfizierten Zellen
- Auswertung der Experimente in der Bibliothek
Gruppe 2

Di 15:00 — 17:00 - theoretische Einflihrung in der Bibliothek
- RNA Isolation der vorbereiteten Proben

Mi 11:00 — 16:30 - Reverse Transkription der isolierten RNA
- Pause
- quantitative PCR
- Transfektion von 293, HuH7 und HuH7.5 fir Gruppe |

Fr 16:30 — 18:00 - Auswertung der Experimente in der Bibliothek
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